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• Make sure the document is stored in a safe place such that it is always available when 
working on or with the device.

• To avoid danger to individuals or the facility, read the "Basic safety instructions" section 
carefully, as well as all other safety instructions in the document that are specific to 
working procedures.

• The manufacturer reserves the right to modify technical data without prior notice. Your 
Endress+Hauser distributor will supply you with current information and updates to these 
Instructions.
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1 About this document

1.1 Document function
This manual should support during the configuration of Tankvision Professional NXA85 and 
LMS NXA86B.
Beside basic PC operating knowledge no special training is needed to perform the Tank 
Gauging System operations. Nevertheless it is recommended receiving a training on the 
system by Endress+Hauser.

1.2 Software versions and certification
Due to the certification process with weights and measures agencies, the latest 
software version might only be certified at a later stage. Also some features might be 
incompatible with the weights and measure regulations and can therefore not be 
combined.

1.3 Symbols

1.3.1 Safety symbols

1.3.2 Electrical symbols 

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

Symbol Meaning

A0011197

Direct current
A terminal to which DC voltage is applied or through which direct current flows.

A0011198

Alternating current
A terminal to which alternating voltage is applied or through which alternating current flows.

A0011200

Ground connection
A grounded terminal which, as far as the operator is concerned, is grounded via a grounding 
system.

A0011199

Protective ground connection
A terminal which must be connected to ground prior to establishing any other connections.

DANGER

WARNING

CAUTION

NOTICE

)

*
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1.3.3 Symbols for certain types of information

1.3.4 Symbols in graphics

1.4 Documentation
The following documentation types are available in the Downloads area of the 
Endress+Hauser website: www.endress.com/downloads

For an overview of the scope of the associated Technical Documentation, refer to the 
following: 

•W@M Device Viewer: www.endress.com/deviceviewer - Enter the serial number from 
the nameplate

•Endress+Hauser Operations App: Enter the serial number from the nameplate or scan 
the matrix code on the nameplate

1.5 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

Modbus™
Modbus is a registered trademark of Schneider Electric USA, Inc.

Java®

Registered trademark of Sun Microsystems, Inc.

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Enraf, Honeywell, Rosemount, Emerson, Saab, L&J, VAREC, GPE are registered trademarks 
and trademarks of these organizations and companies.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

1. 2. 3.

1. 2. 3.

-

.
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All other marks are property of their respective owners.

2 Basic safety instructions

2.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfill the 
following requirements: 
• Trained, qualified specialists: must have a relevant qualification for this specific function 

and task.
• Are authorized by the plant owner/operator.
• Are familiar with federal/national regulations.
• Before starting work, read and understand the instructions in the manual and 

supplementary documentation as well as the certificates (depending on the application).
• Follow instructions and comply with basic conditions.

The personnel must fulfill the following requirements for its tasks:
• Trained, qualified specialists must have a relevant qualification for this specific function 

and task.
• Are authorized by the plant owner/operator.
• Are familiar with federal/national regulations.
• Before starting work, read and understand the instructions in the manual and 

supplementary documentation as well as the certificates (depending on the application).
• Follow instructions and comply with basic conditions.

The operating personnel must fulfill the following requirements:
• Are instructed and authorized according to the requirements of the task by the facility's

owner-operator.
• Follow the instructions in this manual.

2.2 Intended use

2.2.1 Application

Tankvision Professional NXA85

Tankvision Professional is specifically designed for operators of bulk storage facilities, 
marketing terminals, refineries and pipelines. It is designed to handle all the data 
acquisition, supervisory control and monitoring required in a single fully integrated solution.

Tankvision Professional integrates all major types of tank measurement instruments into 
one system.

All measured and calculated tank parameters are accessible to your tank farm and terminal 
operators as well as to connected host systems.
Multi-user operation is provided by the inbuilt Web Server offering the opportunity to access 
data at any connected location (local or remote) e.g. for administrative and accounting 
purposes.

Tankvision LMS NXA86

Tankvision LMS is a total LNG Tank Storage and Management solution for Peak Shaving, 
Receiving and Production LNG facilities. The LMS system has been designed to interface to 
all instruments commonly found on LNG storage tanks, and to collect and present the 
instrument data through a range of intuitive graphical user interfaces. A typical LNG Tank 
will have a wide range of measurement instruments to measure Liquid Level, Liquid Density, 
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Liquid and Vapour Temperature, Liquid and Vapour Pressure, Skin Temperature and much 
more.

Typically each tank would be fitted with an LTD gauge, two further level gauges configured 
as a Primary and Secondary, and an Alarm Gauge. The LTD gauge is a servo operated unit 
mounted on the tank roof. The purpose of the LTD gauge is to take accurate profiles of 
temperature and density throughout the liquid, and whilst not profiling provide continuous 
liquid level, temperature and density measurement. The Primary and Secondary gauges can 
be either servo and or radar operated units also mounted on the tank roof. The purpose of 
these gauges is to provide continuous liquid level measurement, and average liquid 
temperature measurement. They provide redundancy on the measurement of level and 
temperature. The average liquid temperature is derived from a multi-point temperature 
sensor device. The alarm gauge is often a servo or radar based gauge configured to provide 
volt free contact alarm status to an independent system.

An LMS system can operate in a simple standalone configuration or as a fully redundant 
system where security and integrity are of paramount importance. The LMS system has a 
flexible and scalable architecture allowing it to be tailored to a number of different 
applications easily.

2.3 IT security
Our warranty is valid only if the product is installed and used as described in the Operating 
Instructions. The product is equipped with security mechanisms to protect it against any 
inadvertent changes to the settings.

IT security measures, which provide additional protection for the product and associated 
data transfer, must be implemented by the operators themselves in line with their security 
standards.
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3 Identification

3.1 Product identification
The following options are available for identification of the software:

• Nameplate specifications
• Order code with breakdown of the software features on the delivery note
• Enter serial numbers from nameplates in W@M Device Viewer: 

www.endress.com/deviceviewer - All information about the software is displayed.

3.2 Nameplate
The information that is required by law and is relevant to the device is shown on the 
nameplate, e.g.:
• Manufacturer identification
• Device name
• Order code
• Extended order code
• Serial number
• Barcode

3.3 Manufacturer address
Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Germany

Place of manufacture: See nameplate.

3.4 Order code and device version
To find out the version of your software, enter the order code indicated on the 
nameplate in the search screen at the following address: 
www.products.endress.com/order-ident
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4 System Configuration
The System is provided with a suite of configuration tools allowing the user to create and 
configure their own database to reflect their own site configuration.
It is however recommended that any user wishing to configure a complete system attends a 
recognised training course at an approved support centre.
This manual assumes that the system software has been correctly installed in accordance 
with the Installation manual and any other release notes and instructions provided by the 
software manufacturer.
In order to successfully configure a system the following information will be required as a 
minimum:

• Tank details such as:
– Tank Identity
– Tank Shape
– Tank Operating Parameters
– Alarm set-points
– Calibration Table
– Product Name

• Gauge details such as:
– Gauge Type
– Gauge Address
– Data Items supported
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5 Tank Capacity Data Configuration

5.1 Tank Capacity Data Configuration Introduction
Tank capacity tables are required to enable the system to calculate inventory data.
Each capacity table needs to be either entered manually or imported from a comma 
separated value (.CSV) format text file.

The accuracy of the volumes calculated by the system is dependent upon the accuracy 
of the tank capacity points provided.

The utmost care must be taken when selecting the capacity points to be used. Where 
possible the original tank strap points should be entered to get the best accuracy. Access to 
this feature can be managed by the security system.

It is not necessary to use the same name for the Tank and the tank capacity table but 
this nomenclature has been used for the demonstration tables for simplicity.

5.2 Loading the Tank Capacity Table Module
To load the Tank Capacity Table Module, proceed as follows:

Select Configuration → Tank Capacity Tables from the main menu.

The Tank Capacity Table module main window will be loaded as follows:

BA00390GEN_0272

The list of tables will be populated with all tank capacity tables currently configured.

Tank Capacity Tables are assigned to tanks in the Configuration → Configuration 
menu option (→ ä 29).

•Selecting File → New from the menu will allow naming and editing of options and 
data to create a new tank capacity table.
•Selecting File → Import Points will cause the import points screen to be displayed for 
import of a CSV file. 

1.
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5.3 Adding a New Tank Capacity Table
To add a new tank capacity table, proceed as follows:

Select File → New.
The new tank capacity table window opens as follows:

BA00390GEN_0273

In the Table ID field enter a name for the new table and select whether the table role is 
Standard, Water or Hydrostatic Deformation.

1.

2.
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BA00390GEN_0274

Then select type from Innage, Ullage, Delta Innage, Delta Ullage or Polynomial.
Enter a valid From date in the format 01/04/2011 00:00 (invalid format is ignored).

Finally enter or import the points (up to 60,000) for the tank and then select File → 
Save.

5.4 Importing a Tank Capacity Table
To import a tank capacity table, proceed as follows:

Click the Import Points icon (  ).
A dialog box will appear warning that any existing points will be replaced if you 
continue.

BA00390GEN_0004

If you choose to continue you will be prompted to enter a choice of CSV, Excel or Database 
for the source data and given an option to change the engineering units for level and volume.

3.

4.

5.

1.
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BA00390GEN_0005

Enter the path or browse to the location source data file. Select the relevant file and click 
the Open button to import the calibration data into the database.

BA00390GEN_0006

Any problems encountered while processing the data will be reported to the user. You will 
notice in the screenshots above a button labelled Graph. This opens a simple chart plot 
showing the characteristic of the calibration data. This is a useful aid to spot any erroneous 
data.

2.
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BA00390GEN_0276

The plotted characteristic should be almost linear for Vertical Cylindrical tanks. For spherical 
and horizontal cylindrical tanks the plotted chart should exhibit a non-linear characteristic.

5.5 Viewing Existing Tables
Select Configuration → Tank Capacity Tables from the main menu.
The Tank Capacity Module will be loaded (→ ä 12).

Select a Capacity Table to view the points and data.

Tables which have been superseded by use of the Valid From field can be seen in the history 
tab.

1.

2.
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5.6 Editing Values in an Existing Table
To edit values in an existing capacity table, proceed as follows:

Select the table to be edited from the list.
If you have the necessary security access rights you will be able to edit the table of values.

Type in the new value and move off the row to save the changes locally to the table.

BA00390GEN_0277

To save the changes click the  icon on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

5.7 Inserting an Extra Row
To insert an extra row, proceed as follows:

Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Insert option.
A new row will be inserted.

1.

2.

3.

1.

2.
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BA00390GEN_0278

Enter the data for the new row.

To save the changes to the database click the  icon on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

5.8 Addinging an Extra Row
Adding using the Add button is much the same as inserting (→ ä 16) but appends a row to 
the end.

5.9 Deleting Rows
To delete a row, proceed as follows:

Select the row which needs to be deleted by clicking with the left mouse button on the 
left hand side of the row.

Select the Delete option.
The row will be deleted.

To save the changes to the database click the  icon on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

5.10 Validity of Data
The user is not allowed to enter points in the wrong order, all levels and volumes must 
be larger than the previous one. The border around the data entry points will remain 
red until entered data is valid.

3.

4.

1.

2.

3.
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6 Density Table Configuration

6.1 Density Table Configuration Introduction
Density tables are required if the user has selected Density Table as a volume correction 
method.
The utmost care must be taken when selecting the density points to be used to get the best 
accuracy.
The use of this feature can be controlled by the security system.

6.2 Loading the Density Table Module
Select Configuration → Density Tables from the main menu.
The Density Table module main window will be loaded as follows:

BA00390GEN_0011

The list of tables will be populated with all density tables currently configured.

Density tables are assigned to tanks in the Configuration → Configuration menu 
option.

•Selecting File → New from the menu will allow naming and editing of options and 
data to create a new density table.
•Selecting File → Import Points will cause the import points screen to be displayed for 
import of a CSV file. 

6.3 Adding a Density Table
Select File → New.
The new tank capacity table windows opens as follows:

1.

1.
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BA00390GEN_0012

In the Table ID field enter a name for the new table.

BA00390GEN_0013

Finally enter or import the points (up to 200) for the tank and then click File → Save.

6.4 Importing a Density Table
Select Table → Import.
A dialog box will appear warning that any existing points will be replaced if you 
continue.

2.

3.

1.
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BA00390GEN_0014

If you choose to continue, you will be prompted to choose the CSV file containing the source 
data and given an option to change the engineering units for level and volume.

BA00390GEN_0015

Enter or browse for the source data file details.

BA00390GEN_0016

Select the relevant file and click the OK button to import the calibration data into the 
database.
Any problems encountered whilst processing the data will be reported to the user.

6.5 Viewing Existing Tables
Select Configuration → Density Tables from the main menu.
The Density Table Module will be loaded as follows:

2.

1.
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BA00390GEN_0011

Select a Density Table to view the points and data.

6.6 Editing Values in an Existing Table
Select the table to be edited from the list.  If you have the necessary security access rights 
you will be able to edit the table of values.

Type in the new value and move off the row to save the changes locally to the table.
The row will be deleted.

To save the changes to the database click the  button on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

6.7 Inserting an Extra Row 
Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Insert option.
A new row will be inserted.

BA00390GEN_0018

2.

1.

2.

3.

1.

2.
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Enter the data for the new row.

To save the changes to the database click the  icon on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

Adding is much the same as inserting but appends a row to the end of the list of points.

6.8 Deleting Rows
Select the row which needs to be deleted by clicking with the left mouse button on the 
left hand side of the row.

Select the Delete option.
The row will be deleted.

To save the changes to the database click the  icon on the tool-bar.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

6.9 Validity of Data
The user is not allowed to enter points that are out of the temperature or density range. 
The border around the data entry points will remain red until entered data is valid.

3.

4.

1.

2.

3.
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7 Configuration Tool
The configuration tool allows entry and editing of the main tank, device and inventory 
operating parameters.
It is essential that all applicable parts of this configuration are configured correctly and 
accurately. Failure to do so may result in loss of field communications and/or inaccurate 
inventory calculations.

The configuration tool can be notionally divided into several sections:

1. DCC Configuration
a. DCC Host Settings

b. Port Settings

2. Tank Configuration
a. Sites
‣Tanks

– Tank Properties
– Tank Capacity Table assignments
– Tank Metrics
– Hybrid Settings
– Device Mappings
– Alternate Live Data Sources
– Product  Characteristics
– Tank Inventory Control Settings

Within the configuration tool some data items are dependent on other settings. Indeed some 
fields are not vis- ible or enabled until they are called for by the setting of another parameter. 
These are briefly listed below.
The use of this feature can be controlled by the security system.

7.1 Inter-relation of configuration items
Some settings are specific to certain calculation methods, these are listed below:

7.1.1 Product Characteristics screen
Details Section
• JIS (Japanese Industrial Standards) Calculation Method is only enabled when a JIS Volume 

Correction Method and a floating roof tank shape are selected.
• Selecting GBT or GBT(Direct_Weight) implies that a Hydrostatic deformation Table is in 

use. Not applying such a table will result in the failure of calculated values.

VCF Settings Section
• Enraf polynomial constants A and B require the EnrafChem2Poly or EnrafChemPoly1 

volume correction method. Constants C, D and E are only available when EnrafChemPoly1 
is selected.

• The label ‘Chemical Concentration’ changes to ‘Alcohol strength by volume’ or ‘Alcohol 
strength by mass’ depending on the type of chemical calculation selected and should 
always be entered as a percentage.

• Product Reference Temperature can only be changed if the selected volume correction 
method does not specify a fixed reference temperature to be used.

Type of calculation Label

HMD, Nitric Chemical Concentration

OIML R22 STRxVOL Alcohol strength by volume

JIS K2250 STRxVOL Alcohol strength by volume

OIML R22 STRxMASS Alcohol strength by mass
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• Temperature Correction Factor and Density Correction Factor can only be specified if the 
corresponding volume correction methods of TCF or DCF (respectively) are selected.

All Sections
• It is possible to allocate certain characteristics to products using the Product Configuration 

tool (→ ä 82). If such a product is selected in the Details Section then the characteristics 
of that product will override and disable the corresponding settings in this configuration 
tool. This is made clear to the user and will be demonstrated later in this manual.

7.1.2 Tank Metrics screen
Floating roof settings are only enabled if the tank shape is set as Vertical Cylinder (Floating 
Roof).

7.2 Launching the Configuration Tool
Select the Configuration → Configuration option from the main menu.
The initial display is shown below.

BA00390GEN_0279

Each part of the configuration tool will be dealt with below in the order shown above 
(→ ä 23).

1.
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7.3 DCC Configuration

7.3.1 DCC Host Settings
Please refer to the DCC Configuration manual BA00391G.

7.4 Tank Configuration

7.4.1 Sites
In Tankvision Professional/LMS tanks are always associated with a site which may be a user 
defined site or the system provided Default site.

Adding a site

New sites can be added either by right-clicking on the Tank Configuration tree item or by 
selecting the Tank Configuration tree item and clicking the Add Site tool-bar button (see 
below).

BA00390GEN_0280

Once added the site name should be changed to reflect the users’ preference (see below).
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Maintaining a site

There are a number of options available to maintain a site.
• Add Tank

Add a new tank to an existing site.
Either select the desired site and click the Add Tank tool-bar option or right-click the 
desired site and select Add Tank.

• Clear Site
Clear the site of all tanks.
Right-click the desired site and select Clear Site.

• Delete Site
Delete the site completely.
Either select the desired site and click the Delete Site tool-bar option or right-click the 
desired site and select Delete Site. The user will be presented with a warning before the 
site is actually deleted.

BA00390GEN_0282

7.4.2 Tanks
Expanding a site under the Tank Configuration section will display all currently configured 
tanks attached to that site.
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Adding a Tank

To add a new tank to the tree view, right click on the site you wish to add the tank to, then 
click Add Tank. The dialog box below will be displayed:

BA00390GEN_0284

Name

A template which the application uses to add multiple tanks at once. When adding multiple 
tanks, the tank prefix follows a specific syntax; any text characters in the field will be added 
to the prefix of the tank name. Any 0’s indicate the trailing zeros after the prefix. E.g. if the 
tank prefix was ’TK000’ and 10 tanks were added, they would be given the following names:
• TK001
• TK002
• TK003
• TK004
• TK005
• TK006
• TK007
• TK008
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• TK009
• TK010

Number of tanks

The number of tanks that will be added. A maximum of 100 tanks can be added at once, and 
5000 tanks can be added in total.

Start index

The number at which the new added tanks will start at. E.g. if the tank start count was 10 
and 5 new tanks were added, the new tanks would start at 10 and count up 5 to 14.

Removing a tank

A tank can be removed by selecting the desired tank and clicking the Delete Tank tool-bar 
button or by right-clicking the desired tank and selecting Delete Tank from the pop-up 
menu.

Configuring a tank

Clicking on a tank expands the various configurable properties for that tank (see below).

BA00390GEN_0285

In the initial screen the tank name can be edited. Clicking on any item below the tank opens 
the corresponding configuration section.

Tank Properties

Configure various generic properties of the tank.
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Notes

Allows the user to record notes in relation to the tank. A time-stamp is recorded whenever 
the notes are edited.

Percentage Level

Determines which data parameters are used to produce the percentage level data value. For 
the settings shown in the screenshot above:
PercentageLevel = (ProductLevel / LevelExtent) * 100

Percentage Volume

Determines which data parameters are used to produce the percentage volume data value. 
For the settings shown in the screenshot above:
PercentageVolume = (TotalObservedVolume / MaximumOperatingVolume) * 100

Molecular Mass

The molecular mass of product in the tank.

Tank TCT

Configure properties related to tank capacity tables.
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Tables

• Product Table
Selects the product tank capacity table to apply to this tank.

• Water Table
Selects the water tank capacity table to apply to this tank.

• Hydrostatic Deformation Table
Selects the hydrostatic deformation table to be used with this tank.

Capacity Details

• Level Extent
This field is not editable. It displays the highest level value in the currently selected product 
tank capacity table for reference only.

• Reference Height
The reference height for this tank.

• Shell Capacity
The capacity of the entire tank shell.

Operating Levels

• Minimum Operating Level
The defined minimum operating level of the tank. The accuracy of this value is important 
as it used to determine the minimum operating volume and consequently the amount of 
Usable Volume in the Tank.

• Maximum Operating Level
The defined maximum operating level of the tank. The accuracy of this value is important 
as it used to determine the maximum operating volume and consequently the amount of 
Ullage Volume (Avail- able Room) in the Tank.
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Calibration Details

• Adjustment Volume
A fixed volumetric adjustment (either +ve or –ve) applied to the volume obtained from the 
Tank Capacity table. This accounts for any manifold or pipeline volume to be added or any 
deadwood to be removed.

• Calibration Density
The density of the medium in a tank when that tank was calibrated. This setting is only 
relevant in JIS based calculations.

Tank Metrics

Configure settings regarding the physical properties of the tank itself.

BA00390GEN_0288

Tank Shape

• Tank Shape
The physical shape of the tank. Four principle tank shapes are supported:
– Vertical Cylinder
– Horizontal Cylinder
– Vertical Cylinder (Floating Roof)
– Sphere
There are other similar tank shapes; however, most should fall into one of the above types. 
Vertical Cylinders that have internal floating blankets/decks should be configured as 
VCFR.
It is essential that the tank shape is entered correctly as this affects the inventory 
calculation algorithms.

Tank Shell Settings

• Shell Insulation Factor
For completely insulated storage. 0.875 is a typical value (0 for non-insulated storage)

• Shell Temperature coefficient
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Expansion coefficient of the material the tank is constructed from. e.g. 0.0000112 for mild 
steel

• Shell Reference Temperature
Normally the same reference temperature used for your VCF calculations. (usually either 
15 °C or 30 °C)

Floating Roof Settings

Some floating roofs have legs which may be set at two positions, thus altering the level at 
which the roof floats or is supported on the legs. Since the legs are usually attached to the 
floating roof, the "up" position of the legs allows the roof to descend to a lower level in the 
tank, and is the setting used in normal operation, whereas the "down" position causes the 
roof to become supported on its legs at a higher level and is the setting used for maintenance 
purposes. Where a tank has a floating roof with fixed or one - position legs, it is advisable to 
set the "Legs Up" and "Legs Down" levels to be the same, so that the Legs "Up/Down" selection 
becomes irrelevant.

• Roof Weight
The weight of the floating roof.

• Roof Floating Legs Down
The point at which the roof just ceases to be resting on its legs when the legs are in the 
"down" or maintenance position, such that the whole weight of the roof is being supported 
by its buoyancy in the product. Above this level, compensation is made for the 
displacement of the product by the full weight of the roof.

• Roof Floating Legs Up
The point at which the roof just ceases to be resting on its legs when the legs are in the "up" 
or operational position, such that the whole weight of the roof is being supported by its 
buoyancy in the product. Above this level, compensation is made for the displacement of 
the product by the full weight of the roof.

• Roof Support Legs Down
The point at which the roof legs are supporting the full weight of the roof when the legs 
are in the "down" or maintenance position. Below this level, no compensation is made for 
product displace- ment caused by roof weight.

• Roof Support Legs Up
The point at which the roof legs are supporting the full weight of the roof when the legs 
are in the "up" or operational position. Below this level, no compensation is made for 
product displacement caused by roof weight.

• Roof Legs Down
Indicates that the legs are in the up or down position.

The area between the Fully Supported and Fully Floating levels is generally referred to as the 
roof transition zone. Between these levels it is difficult to determine the proportion of the 
roof’s weight which is being held by the legs and therefore difficult to calculate the 
displacement of product by the roof. For this reason this region of the tank is normally 
avoided during normal operation.

Pressure Sensor Settings

A pressure sensor must be enabled by selecting the check-box before it’s configuration can 
be changed.
• Base Pressure Height

The level at which the Base Pressure sensor is physically mounted.
• Product Pressure Height

The level at which the Product Pressure sensor is physically mounted.
• Vapour Pressure Height

The level at which the Vapour Pressure sensor is physically mounted.
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Tank Bottom Details

• Tank Sump Volume
The volume of product in the bottom sump of the tank, below the measured range of the 
level gauge (typically below a product level of 0 mm (0 in)). The application of this value 
is dependant on the current tank mode. If the current tank mode includes the ”Exclude 
Sump from Inventory” option, the value will be added to ullage volumes, otherwise it will 
be applied to the innage volumes.

Any value entered in this field will always be applied in some way to volumes in the 
system. Customers whose sump volume is already included in their tank capacity tables 
should set this value to zero.

• Empty Tank Threshold
The level used to check the tank mode state if the ”Automatic Reversion to Default Tank 
Mode” flag is set for the current tank mode. When the product level moves above this 
threshold the tank mode will automatically revert back to the Default mode.

Hybrid Settings

Configure settings for hybrid (pressure derived) density calculations.

BA00390GEN_0289

• Hybrid Density Enabled
Enables calculation of observed density from pressure data.

• Hybrid Min Level
The minimum level above which the hybrid calculation will be carried out.

• Hybrid Level Hysteresis
Hysteresis for the Hybrid Min Level value.

• Hybrid Min Pressure
The minimum pressure above which the hybrid calculation will be carried out.

• Include Water
Take account of water level in the hybrid calculation.

• Use Vapour Pressure
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Include vapour pressure data in the hybrid calculation.

Device Mapping

The Device Map section allows the user to map previously configured devices to tanks.

BA00390GEN_0290

To map a device to the current tank:
• Click the Add Device button (see screenshot above). A device mapping entry will appear 

and the Device selection box will be populated with currently unassigned devices.
• Select the required device and select its Duty (see screenshot below).
• Continue adding devices as necessary.
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Alternate Live Data Sources

These settings allow the data source for a specific data item to be changed to originate from 
a different device to that attached to the current tank.
Clicking one of the drop down selection boxes displays a list of available devices. Clicking 
Reset to primary device resets all the fields to their defaults.
For example, it is possible to direct the system to read Observed Temperature for tank 
TK001 from the primary device on TK007 by selecting the relevant device for TK007 in the 
Observed Temperature Data Source. This will instruct the system to override any value 
read from TK001 devices for this data value and instead use the value from the selected 
device on TK007.

The system will use the value from the alternate device even if the device does not 
support the data item or the data item is invalid.
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Product Characteristics

Configuration items relevant to the product contained in the tank.

BA00390GEN_0293
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Details

• Product
Specifies the pre-configured product to be stored in the selected tank. Products can be 
configured to have certain pre-selected characteristics attached to them. Products with 
characteristics are identified by being highlighted in yellow. Selecting a product with 
characteristics will override and disable certain settings within the configurator tool – an 
alert message is displayed in green at the top of the window to warn the user of this as 
shown below. The values that will be overridden are those configured as product 
characteristics in ‘Product Configuration’ (→ ä 82).

BA00390GEN_0294

• Volume Correction Method
Here the method to use for volume calculations is chosen. It is essential that the volume 
correction method is selected correctly as this affects the inventory calculation algorithms.

• Standard for Calculations
By selecting a suitable calculation method, the user can cause some of the calculation 
settings to be pre-set to values which are the accepted (or defined) default for the relevant 
standards body or type (→ ä 140). These settings are then locked. If the user wishes to 
change these locked values, the Standard for Calculations must be reset to ‘None’. Certain 
calculation types rely on this setting. For example, Hydrostatic Deformation will only be 
included if the Method of Calculation has been set to GBT or GBT (Direct Weight).

In the case of JIS MDP calculations, setting the control flag VCF is restricted forces the 
rounding of input data to use +/- 0.002 kg/l and +/- 0.25 °C for density and 
temperature respectively.

• JIS Calculation Method
Specifies the handling of floating roof corrections within JIS calculations. This option is 
only available upon selection of a floating roof tank shape and a JIS volume correction 
method.

• Density Table
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Specifies the density table to be assigned to this tank. This setting is only available if a 
Density Table volume correction method is chosen.

• Vapour Calculation Control
Specifies the vapour correction calculations that will be performed as part of the inventory 
calculations. None means that no vapour correction will be performed.

• Metering Temperature / Combustion Temperature
The specified temperature at which the amount of fuel to be burned is notionally 
determined for calorific calculations.

VCF Settings

BA00390GEN_0295

• Vapour Density
The Average density of vapour above product.

• Thermal Expansion Coefficient
The volumetric expansion coefficient (or alpha) factor of the product in the tank.

• Temperature Correction Factor
The temperature correction factor for the product.

• Density Correction Factor
The density correction factor for the product.

• Manual VCF
Volume Correction Factor that will be used if the Manual volume correction method is 
selected.

• Product Reference Temperature
A custom reference temperature for the selected volume correction method. This may only 
be changed if the volume correction method chosen does not specify a product reference 
temperature.

• Liquid Vapour Ratio
The ratio of liquid to vapour.

• Chemical Concentration
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The ’strength’ of the product. This may also be displayed as Strength by Volume or 
Strength by Mass depending on the choice of volume correction method (→ ä 23).

• Enraf Polynomial Coefficients A-E
Coefficients defining a curve fit of tank capacity table data.

Product Inventory Flags

BA00390GEN_0296

These settings control the way the inventory calculations are performed in relation to the 
product in the tank (→ ä 141).
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Tank Inventory Flags

BA00390GEN_0297

These settings control the way the inventory calculations are performed in relation to the 
tank itself (→ ä 142).
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8 Alarm Configuration
The alarm/event sub-system included with the system is highly configurable.
Access to the feature can be controlled by the security system.

8.1 Alarm Overview
The alarm/event sub-system is based on a Windows service.
The alarm system consists of an EventServer which distributes alarms and events as they 
occur to any connected AlarmEventViewer clients.
The EventServer may be configured to distribute only a sub-set of alarms to individual 
AlarmEventViewer  clients and each client may be configured to display and annunciate 
alarms as required.
The AlarmEventViewer is the principle way of viewing alarms and only one instance runs per 
machine, although multiple client machines may connect to a single EventServer.
The following is a typical view of an Alarm Event Viewer:

BA00390GEN_0171

8.2 Event Server Configuration
The Event Server’s role is to send new alarm notifications to any Alarm Event Viewer clients 
connected to the system. These could be locally on the same PC or on networked client PCs.

The Event Server may be configured for a range of functions, including:
• Defining the severity of alarms.
• Defining what text to display for an alarm.
• Determining what alarms are sent to individual clients.

The Event Server also monitors the health of the alarm sub-system and if any of the 
following services fail, then an Event Subsystem Failed alarm will be sent to all client 
viewers:
• DCCHost
• RTDBAccessor

8.2.1 Configuring the Event Server
To configure the Event Server, proceed as follows:

Right click on the Service Manager icon in the Windows system tray and select the 
Event Server Service → Event Server Config option.

1.



Alarm Configuration Tankvision Professional NXA85, LMS NXA86B - System Configuration

42 Endress+Hauser

BA00390GEN_0298

Expand the left hand panel to select one of the areas to edit, or click on the underlined 
item in the right hand panel.

BA00390GEN_0036

The four selections are:
• Settings: Configure the internal settings for the Event Server
• Clients: Configure any unique client definitions
• Events: Configure the definition for each alarm/event type
• Databases: Configure the database maintenance parameters

There are toolbar icons to add/remove a client, override or remove over-ride for an alarm 
and to change event options.

2.
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8.2.2 Settings
This page allows various settings for the Event Server itself to be configured. Generally 
speaking, most of these should be left as their default values.

BA00390GEN_0265

The following settings may be configured:

TCP Port

This is the network port used to listen for connections from Alarm Event Viewer clients. If 
this is changed then any Alarm event Viewer client should have their configuration changed 
to match it. This value should only be changed if there is a clash with some other software 
running on the PC.

Interval

This is the update time for the server, increasing it will slow down alarm updates. It should 
not be changed unless the PC is running at a very slow speed.

Sender E-Mail Address

This is the e-mail address displayed in the sender field of any e-mails that are sent 
containing alarm details.

Ack Duplicate Events

By default this item is ticked, in which case if there are multiple occurrences of the same 
alarm in the database then acknowledging one will acknowledge all of them. If this item is 
unticked then each alarm has to be individually acknowledged. This should only be unticked 
if clients are using the Legacy Mode for events.
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Log Exceptions

If this is ticked then any problems that the server encounters will be logged to a file on the 
hard drive. The file will be called Event.Server.Exceptions.txt and will be located in the 
standard install directory for tank gauging.
It may be useful to log errors to assist in diagnosing network access problems.
For instance if a remote client on the network is not receiving automatic updates of events 
then it may be due to a number of problems such as the Windows firewall blocking on the 
client. This would show up in the log file on the server.

Redundancy Settings

This setting needs to be configured to create alarm synchronization among the redundant 
pairs. Alarm synchronization means that acknowledging alarms on one server automatically 
acknowledges the alarms on the second server. By default this option is unticked. Selecting 
this option enables the following options.

Local Sync Port

Port number used by the local Event Server to listen for connections from the remote Event 
Server on the redundant partner machine. This can be any number and that needs to be 
provided as the Remote Synch Port in another server.

Remote Sync Port

Remote port number used by the local event server to listen for connections from the local 
Event Server on the redundant partner machine. This number should be same as the Local 
Sync Port on the other server.

Remote Sync Host

Host Name of the redundancy partner.

The above settings must be completed on both servers of a redundant pair.



Tankvision Professional NXA85, LMS NXA86B - System Configuration Alarm Configuration

Endress+Hauser 45

8.2.3 Client Definitions
This page allows the alarm/event sources for clients to be configured. For example, clients 
can be configured to only receive alarms for a sub-set of the tanks, or to receive nothing at 
all.

BA00390GEN_0039

The client name is either:
• The name of the client PC on the network (including the name of the PC that the server 

runs on, as the Alarm Event Viewer on that machine counts as a client), and must be 
unique.

• The telephone number of a mobile telephone which is to be used as an SMS client.
• The e-mail address which is to be used as a client for e-mailing alarms.
• The port name which is connected to an ASCII printer which is to be used to output alarms. 
• The telephone number of a telephone which is to be used as a voice client.
• The name of a radio network (configured in the messaging service or remote radio 

module) which is to be used to broadcast alarms as radio messages.

Add Client

Clients may be added or deleted as required.
There is always a client called default which cannot be deleted and this is used as the 
definition for a connecting client if one does not exist. For most standalone systems no extra 
client definitions are required, as the default will be used.

To display a client definition:

Select it from the Show settings for list. All parameters on the screen will be set to the 
selected client.

To add a new client definition:

Click on the Add Client button which will open a dialog.

1.

1.
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Select the type of client required:

Click OK and the new client will be displayed in the list and the parameters will be 
cleared.

Delete Client

To delete a client definition:

Select the client in the list and click on the Delete Client button.

Deleting a PC client definition will not stop the client from receiving alarms. It will 
simply use the default definition.

For each client the following parameters may be configured:

2.

Client Type Identity Details

PC Client Client Name The name of the client PC on the network.  
This can either be typed in, or selected from 
the dropdown list of available PCs.

Mobile Phone (SMS) Phone Number Only available if the feature is licensed. The 
telephone number of the mobile phone 
which is to act as an SMS client.

E-Mail (Plain Text) E-Mail Address The e-mail address which is to act as a 
recipient of plain text e-mail messages 
containing alarm details.

E-Mail (HTML) E-Mail Address The e-mail address which is to act as a 
recipient of HTML e-mail messages 
containing alarm details.

ASCII Printer Port Name The name of the COM port the ASCII printer 
is connected to.

Radio Radio Only available if the feature is licensed.  
Selected from a dropdown list of the radio 
networks configured in the messaging 
configuration.

Remote Radio Radio See Remote Radio Client Configuration for 
details.

Telephone Phone Number Only available if the feature is licensed. The 
telephone number of a phone which is to act 
as a voice client. There is an additional field 
(Use Outside Line) which indicates if an 
outside line is to be used as configured in the 
messaging service configuration.

3.

1.
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Remote Radio Client Configuration

The remote radio client is a special case and requires additional configuration when being 
added. The client is a standalone Radio Module which connects to the site radio and is 
available separately from your supplier. When the Remote Radio option is selected, a button 
is available which gives access to the configuration parameters:

A0043773

Clicking this button will display the network radio settings screen.

The configuration fields are:
• Radio

The name of the radio to be used to broadcast the alarm. This must match the name of the 
radio configured in the Radio Module at the given address

A0043774

• Use TLS
Indicates whether transport layer security is to be used to connect to the Radio Module

• IP Address
The network address of the Radio Module

• Port
The port used to connect to the Radio Module. This must match the number of the port 
configured in the Radio Module at the given address

• User Name
 The user name required for operations if the Radio Module has been configured to use 
operation security

• Password
The password required for operations if the Radio Module has been configured to use 
operation security

It is also possible to search for Radio Modules that are connected to the network. To do this, 
click the Search button . This will display the Find Network Radios screen:
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Selecting the required radio and then clicking the OK button will close the screen and 
populate the configuration screen with the radio details. NB. This does not include the user 
name and password. If these are required they must still be entered manually.

Legacy Mode Events

This sets the client in the same mode as used on older versions of the tank gauging system, 
where multiple occurrences of the same alarm will each have their own entry displayed and 
will have to be acknowledged individually.

Display System Events

Certain alarms or events are defined as system events, such as system failure events etc. The 
annunciation of these can be prevented on a client by unticking this box.

Display Movement Events

Events generated by the Movement Server service can be stopped from being annunciated 
on a client by unticking this box.

Display Communications Events

The DCC Host service generates a range of communication events, such as Communication 
Failure events, or Failed to Connect events etc. These can be stopped from being annunciated 
on a client by unticking this box.

Display Device Events

Device events are the main set of alarms generated for tanks, such as Level Alarms, 
Temperature alarms  etc. These can be stopped from being annunciated on a client by 
unticking this box. These represent the main events in the tank gauging system and 
generally should not be disabled.

Display Selected Events

This allows the filtering of events so that only specified events are sent to the client.

Only Display Selected Severities

This allows the filtering of events so that only events of specified severities are sent to the 
client.

Select Devices

It is possible to configure a client to only receive events from specific devices/gauges. These 
can be specified by clicking on the Select Devices button.
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This will launch the Select Devices screen:

BA00390GEN_0041

To add a device, choose the Selected Devices button, highlight it on the list and click the OK 
button. To delete a device, deselect it in the list and click the OK button.

Select Events

It is possible to configure a client to only receive specified events. These can be specified by 
clicking on the Select Events button (only available when the Display Selected Events field 
has been ticked). 
This will launch the Select Events screen:

BA00390GEN_0042

To add an event, select it from the list and click OK button. To delete an event, deselect it in 
the list and click the OK button.

Select Severities

It is possible to configure a client to only receive events of specified severities.  These can be 
specified by clicking on the Select Severities button (only available when the Only Display 
Selected Severities field has been ticked).
This will launch the Select Severities screen:
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BA00390GEN_0043

To add a severity, tick the relevant item in the list and click the OK button. To delete a 
severity, untick the relevant item in the list and click the OK button.
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8.2.4 Event Definitions
This page allows the definition for each event (an alarm is just a type of event) to be 
configured. This includes the event/alarm text to be displayed on screen and its severity.

BA00390GEN_0044

All the possible events that the system can generate are displayed in the list.
Selecting an event will show its settings in the fields at the bottom of the window.
For each event the following may be configured:

Event Text

This is the text that will be logged to the events database and displayed on the EventViewer 
screen.

Audio Message

This is the message which will be annunciated for radio and telephone voice clients. If no 
message is set up, the event will not be annunciated. 
To edit the message click on the  button next to the field. This will bring up an audio 
messaging edit screen:
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BA00390GEN_0299

For more details on configuring audio messages, → ä 137. The number of times that the 
message is repeated and the interval at which the message is repeated can be overridden 
(only relevant for radio messaging, not telephone messaging). 
To override the number of times the message is repeated, tick the Override Default Repeat 
field and then select the number of times the message is to be repeated. Similarly to override 
the repeat interval for the message, tick the Override Default Repeat Interval and select the 
interval at which the message is to be repeated. Telephone messages will only ever be 
annunciated once regardless of these settings.

Severity

There are four options:
• Critical
• High
• Low
• Log Only

These refer to the priority given to the alarm.
LogOnly alarms will never be displayed in any Alarm Event Viewer clients, but will be saved 
in the events database and may be viewed in the Event Search screen. They are 
automatically acknowledged by the system.

Requires acknowledgement reason

If this box is ticked, the user will be required to enter an acknowledgement reason when they 
acknowledge this type of alarm.
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8.2.5 Database Maintenance
This page allows parameters to be specified to prevent the events database growing to an 
unmanageable size.

BA00390GEN_0046

Auto Ack Events

This field is to be ticked if events are to be automatically acknowledged after a given time 
period. This should only really be used on redundant systems where it is possible that no 
client machines are connected to a particular server and hence the events will never be 
acknowledged, or the user may be swamped with events when a server changeover occurs.

Ack Events after 

This field is used to specify the number of days after which events should be acknowledged.

Auto Truncate Events

This field is to be ticked if events are to be deleted from the events database after a given 
period.

Retain Events for

This field is used to specify the number of days after which events should be deleted from 
the events database.

Auto Truncate Audits

This field is to be ticked if audit events are to be deleted from the events database after a 
given period.

Retain Events for

This field is used to specify the number of days after which audit events should be deleted 
from the events database.
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8.3 Alarm Event Viewer Configuration
To configure the Alarm Event Viewer, proceed as follows:

Choose View → Options from the menu.

BA00390GEN_0047

The following screen will be displayed:

BA00390GEN_0048

To choose the type of options to configure, either select them from the list on the left or 
click on the relevant text on the right.

1.

2.
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8.3.1 Severity Options

BA00390GEN_0049

Show settings for

The drop down list at the top of the page is used to select the severity of the alarm for which 
the options are to be set. Changing the options will only affect the alarms of that severity.

Use Defaults

Reverts all the options for the severity back to their default values.

Background Colour

The background colour to be used to display the severity of an alarm.

Text Colour

The text colour to be used to display the severity of an alarm.

Text

The text to be displayed to indicate the severity of an alarm.

Sound File

The sound file to be played when an alarm of this severity is the highest priority and sound 
is enabled (see Notification Options). If no directory is supplied the file must exist in the 
Media directory contained in the application directory.
• To browse for a new sound file click on the button to the right of the sound file field.

Test

To play the currently selected sound file click on the Test button.

Sample

Indicates how the severity of the alarm will be displayed in the list of alarms.
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8.3.2 Filter Options

BA00390GEN_0174

These options specify how the alarms will be filtered within the alarm event viewer.

Severity

This section allows the filtering of alarms based on their severity.

Display → Silenced Alarms

If this option is ticked, alarms that have been silenced but not acknowledged will be 
displayed in the list.  Otherwise the alarm will be removed from the list when it has been 
silenced even if it has not been acknowledged.

Display → Still Active Alarms

If this option is ticked, alarms that have been acknowledged but are still active will be 
displayed in the list. Otherwise the alarm will be removed from the list when it has been 
acknowledged even if it is still active.

Rows

Allows the user to specify the maximum number of rows to be visible in the list when the 
alarm event viewer is docked at the top or bottom of the screen. All alarms will still be 
present in the list and if the number of alarms is more than the value entered a scroll bar will 
be displayed to allow the user to view details of all the alarms.

Sorting

Allows the user to sort the alarms by Severity, Description, First, Last and Active.
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8.3.3 Visibility Options

BA00390GEN_0258

The first panel on this page allows the user to specify the conditions under which the Alarm 
Event Viewer can be minimized or hidden. This also works in reverse, in that if a new alarm 
is raised which does not meet these conditions the Alarm Event Viewer is redisplayed on 
the screen if it is hidden or minimized.

Hide device number for device alarms alters the description displayed on the main Alarm 
Event Viewer window to either show or hide the Device ID. See screenshots below. If your 
site has only one level gauge per tank, then showing the Device ID may be unnecessary.

BA00390GEN_0259

Alarm Event Viewer with Device ID hidden

xxxxx

Alarm Event Viewer with Device ID shown
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8.3.4 Notification Options

BA00390GEN_0175

Play sound for → Most severe alarm

The 'active' alarm is considered to be the oldest unacknowledged alarm of the highest 
severity, i.e. there may be older unacknowledged alarms but these are of a lower severity 
than the 'active' one.

Play sound for → Oldest alarm

The 'active' alarm is considered to be the oldest unacknowledged alarm irrespective of 
severity.

Play sound relating to → Severity of alarm

The sound relating to the severity of the 'active' alarm (→ ä 55) is continuously played until 
the alarm is acknowledged.

Play sound relating to → Audio message

The audio message configured for the alarm (see events configuration) is played once.

Play sound relating to → Type of alarm

The sound relating to the type of the 'active' alarm is played once. This is typically an 
annunciation of the alarm type. These sounds can be edited by pressing the Edit button 
(which is only available when this option is selected). Pressing the Edit button causes the 
following screen to be displayed:
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BA00390GEN_0176

This list indicates the sound file that will be used for each type of alarm. The file can be 
changed by typing the new file name into the relevant field. Alternatively a new file can be 
selected by clicking on the button which is available when a file name is being edited. If 
no file is entered for an alarm type, the text for the alarm type will be annunciated using the 
Windows Speech Engine. To test the sound that will be played for an alarm type click on the 

 button in the row for that alarm.

Silence Alarm

Allows the user to change the combination of keys that can be used to silence the currently 
selected alarm.

Acknowledge Alarm

Allows the user to change the combination of keys that can be used to acknowledge the 
currently selected alarm.
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8.3.5 Sound Volume Options
The alarm volumes can be altered or muted using the Sound Volumes screen.

BA00390GEN_0054
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8.3.6 Connection Options

BA00390GEN_0177

Show settings for

The drop down list at the top of the page is used to select the server type for which the 
options are to be set. Changing the options on the page will only affect the settings for that 
server type.

Use Defaults

Reverts all the options for the server type back to their default values.

Server

The name of the server to be used for this server type. This can either be typed in directly, or 
selected from the drop down list. Depending on the speed and configuration of the network 
this list can take some time to be fully populated.

TCP Port

The TCP port on which the events service is running on the specified server.

Test

Tests that the events service can be found on the given combination of server and tcp port.
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8.4 Programmable Alarm Configuration
An integrated part of the system is the Alarm Configuration module.
A wide range of programmable alarms are provided allowing the operator/user to have 
control over product movement.

8.4.1 Launching Alarm Configuration
To launch the Alarm Configuration module, proceed as follows:

Select the Alarm Configuration option from the Configuration menu.

BA00390GEN_0178

Expand the Tank to show the different types of alarms that can be configured.

Select one of the alarm groups.

1.

2.

3.
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Unauthorised Movement Alarm

BA00390GEN_0183

The unauthorised movement alarm protects against inadvertent movement of product in 
static tanks. This alarm should be enabled when the tank is to remain static, this has the 
action of internally storing the current GSV for the tank, should the GSV in the tank change 
beyond the predefined threshold limit, then the alarm will be triggered. The alarm should be 
disabled when movement of product into or out of the tank is being done.

The monitoring supports two different methods of detecting unauthorised movements, by 
standard volume and by level. If your tanks are equipped with temperature measurement, it 
is recommended that you use the volume based alarm, as temperature correction is 
incorporated into the calculations and should therefore result in fewer false-positive 
detections. The level based alarm is driven solely by changes in product level, which removes 
a number of other factors from the detection; it could be viewed a crude alternative or a much 
simplified implementation of the volume based alarm depending on your perspective.

Both can be used at the same time, but it will result in twice the number of alarms.

Automatic Control of Unauthorised Movement Alarms

Manual control of the unauthorised movement alarms involves operators deciding when a 
tank’s levels should or should not change and remembering to enable and disable the alarm 
accordingly. This is prone to error unless rigorously administered. The tank gauging system 
has a number of mechanisms which allow for automatic control.

Full and Simple Movements

Set the Automatically Generate Unauthorised Movements flag in the system settings 
(→ ä 97) and the action of starting and stopping a movement on a tank will deactivate and 
activate the unauthorised movement detection on the system. Typically sites adopting this 
approach mandate that all site activities that involve moving product in or out of a tank must 
be run through the tank gauging movements packages. When the Automatic Generate 
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Unauthorised Movement flag is set, enabling the unauthorised movement alarm on a 
particular tank just makes it possible that a tank will be monitored, if the alarm is unset no 
monitoring of the specific tank takes place. This feature is used by sites that have "day" tanks 
that are permanently open to road loading bays, where it is not possible to determine when 
the product level in the tank should or should not be moving.

TAD Tank Modes

Tank modes can be defined that suppress the unauthorised movement monitoring (see 
System Operation manual BA00396G). Modes that have the "Alarms Suppressed" flag set 
will cause tanks assigned that mode to not be monitored for unauthorised movements. 
Changing the mode from an "Alarms Suppressed" mode to one that isn’t causes the start level 
or volume to be recorded as the starting point for the monitoring.

This alarm is often referred to as a "Leak Alarm" although it equally refers to a gain of 
product as well as a leak.

There is only one configuration item for each of the unauthorised movement alarms. The 
major consideration when selecting a threshold for the alarm is to balance the utility in 
warning operators of possible leaks on site and the number of false-positives created by the 
alarms. Allowances need to be made for ”swing” in windy weather, temperature fluctuations 
and the size of the tank: there is no substitute for experience in determining these values.

Theft Alarm

BA00390GEN_0179

The Theft Alarm is similar to the Unauthorised Movement Alarm except that it only 
detects a loss of product and ignores gains. It also has a number of extra features, specific to 
theft monitoring. When the alarm is enabled the current GSV is stored as a starting value 
and any reduction in the volume greater than the threshold figure will then trigger the 
alarm. If the GSV increases then the starting value will be set to the new GSV value, thus it 
will automatically take account of any receipts of product. Once a Theft Alarm has been 
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triggered it will reset itself after a user defined period and re-arm with the current GSV as a 
starting value.

There is just one tank configuration item for the theft alarm, Threshold, which dictates the 
amount of loss that must occur in order to activate the alarm. The amount is defined as a 
volume at standard temperature and conditions. The major consideration to make when 
choosing a threshold is finding a balance between too many false detections caused by 
thermal contractions as the product cools overnight and the timeliness of alerts to theft. 
Larger tanks without temperature measurement and inaccurate gauges will require larger 
thresholds.

Theft Alarm Schedule and Reset Time

The Theft Alarm will only be monitored during user defined periods (i.e. during nights and 
weekends); outside of these periods no alarm will be generated even if the theft alarm is 
enabled. To configure the monitoring periods and the alarm reset period, the software tool 
Theft Monitor Config is used. This tool is only installed on tank gauging servers not clients, 
and can be accessed from the Home Page configuration menu. See figure below.

BA00390GEN_0266

After using this tool it is necessary to start and stop services using the service manager 
utility to set up the alarm.

Alarm Reset

The time in minutes and seconds before alarm is reset. Shown in figure below.
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BA00390GEN_0267

When a theft is detected the alarm will remain active for the reset period (assuming that the 
alarm is not reset before then by an operator) after which alarm is cleared, thus re-arming 
the system to monitor for further losses. Should the thieves return a second time to take 
further fuel the system will then sound a second time. A reset time of 15 to 30 minutes is a 
typical value for this setting. This setting is accessed by selecting the Theft Monitor Days 
node on the left hand panel.

Day of week

Defines a schedule for the alarm on a particular day of the week as shown in figure below.

BA00390GEN_0268

The alarm can be configured to be off for the whole day, be on for the whole day or conform 
to a particular timed schedule. Normally the alarm is deactivated during working hours, for 
example if the site working hours are between 7am and 5pm the Off Hour will be set at 7:00 
and the On Hour at 17:00.

It is not possible to define more than one schedule for a particular day of the week and 
that the Off Hour must be earlier than the On Hour.

Day of year

This defines the schedule for a particular day of the year, and overrides the schedule for the 
day of the week. It is similar to the day of week settings in that the hours are defined in an 
identical fashion. The difference is that the date defines a specific day of the year, e.g. 
Christmas day; 25th December. The same caveats apply as for Day of Week: only the first 
schedule for a particular day is considered, if multiples are defined, and the Off time must be 
before the On time.
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After using this tool it is necessary to start and stop services using the service manager 
tool to set up the alarm.

Movement Alarms

In some circumstances it is necessary to reduce the sensitivity of the Unauthorized 
Movement and Theft Alarms. 
Typical reasons are that radar gauges on empty tanks can give spurious jumps in level that 
would be detected as an Unauthorized Movement or that high winds acting on a floating 
roof tank cause the levels to "swing". In such situations the Unauthorized Movement and 
Theft Alarms can become a nuisance, distracting the operators from the real dangers on 
their site.

BA00390GEN_0261

Use Smoothing for Movement Alarms – apply smoothing to the volume and level used to 
test for the Unauthorised Movement Alarm and the Theft Alarm. The smoothing uses the 
same parameters entered for the flow calculations, i.e. Flow Rate Damping and Flow Rate 
Integration. These are entered in the Device Configuration screens.
Use Noise Reduction for Movement – is similar to the above, but employs a two out of three 
voting mechanism to discard "jumps" in level which can be caused by radar gauges. Each 
successive level reading from the gauge is compared with the previous two readings, the 
most extreme reading is discarded and the level in the tank is considered to be the average 
of the two remaining. In this way outlier readings (i.e. jumps in gauged level) are discarded.

These settings have no effect on the product level and dependent inventory volumes 
and masses, it is only the levels and volumes used by the Unauthorised Movement and 
the Theft Alarm  detection mechanism that are altered.
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Flow Alarms

BA00390GEN_0063

The flow alarms are intended for use when tanks are moving. They are useful to detect that 
flow has exceeded a tank or pipeline design limit or that flow has reduced or stopped perhaps 
due to some fault.
The alarms are configurable for up to 3 zones. The zone transition boundaries for Rising level 
alarms and Falling level alarms can be independently configured.
Transition boundaries may be dragged to the required level or selected and the required level 
typed into the Level entry field.
Flow rates for each zone may be entered by selecting the required zone and typing the Min 
Flow Rate and Max Flow Rate into the appropriate entry field.

Alternatively, clicking the Text link in the top right of the window switches from Graphical 
to Text entry.

BA00390GEN_0064

Entering a negative flow rate value disables an alarm.
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NOTICE
Set the boundaries correctly!
Failure to do so may result in alarms not being triggered.
‣ If only two zones are in use then both the lower transition boundaries must be set to zero.
‣ If only one zone is in use then all transition boundaries must be set to zero.

Gauge Alarms

BA00390GEN_0180

Gauge alarms are those alarms that are generated by the gauging instrument itself. The 
alarm levels displayed here are normally only there for reference purposes.
On some modern technology gauges it is possible to read the gauge alarm settings from the 
gauge automatically.
On older gauges this is not possible and provision is made to enter these manually within 
through this module.

Detection of gauge alarms is done by the gauging instrument and not by the Tankvision 
Professional/LMS software. Tankvision Professional/LMS merely reads the status of 
the alarm bits transmitted to it by the gauge.

Gauge alarm settings are normally set by the gauge commissioning engineer.

• Gauge Alarm High High - The gauge high high level alarm setting.
• Gauge Alarm High - The gauge high level alarm setting.
• Gauge Alarm Low - The gauge low level alarm setting.
• Gauge Alarm Low Low - The gauge low low level alarm setting.
• Gauge Alarm Enable - An operator configurable enable flag.
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Difference Alarms

BA00390GEN_0181

For example a tank fitted with two gauges will have one nominated as the primary gauge 
and the second as a secondary gauge. The system can then monitor the difference between 
the two gauge levels, and compare the difference to the allowable tolerance set by the user. 
If the difference exceeds the tolerance a difference alarm will be generated.

• Difference Alarm Enable - an operator settable signal to determine if the alarm is 
enabled or not.

• Difference Alarm - an operator configurable difference alarm.
• Difference Alarm Hysteresis - operator configurable hysteresis for difference alarm.

If a hysteresis value above the Allowable Tolerance is entered then the following warning 
message is displayed:
Hysteresis is above the Allowable Tolerance!

Click the OK button to clear the warning.
A hysteresis value below the Allowable Tolerance must be entered.

1.
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Deviation Alarms

BA00390GEN_0182

The deviation alarm is used to alert operators to layering occurring in the tank. When two 
consecutive profile points deviate by the specified amount, either in their density readings 
or temperature, an alarm will be generated. This alarm requires the use of gauges capable of 
returning density profiles.

• Deviation Alarm Enable - Enables and disables the alarm.
• Density Profile Deviation - Deviation amount, for density points.
• Temperature Profile Deviation - Deviation amount, for temperature points.
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Programmable Level Alarms

BA00390GEN_0185

Programmable level alarms are triggered according to the gauged level, they can be used on 
gauges where hardware alarms are not available or used in addition to the gauge hardware 
alarms.

• Level Alarm High High - an operator configurable level alarm denoted High High.
• Level Alarm High - an operator configurable level alarm denoted High.
• Level Alarm Low - an operator configurable level alarm denoted Low.
• Level Alarm Low Low - an operator configurable level alarm denoted Low Low.
• Level Alarm Hysteresis - an operator configurable hysteresis value.
• Level Alarm Enable - an operator configurable enable flag.

The term High High is normally associated with the extreme upper limit to which a 
tank would be filled. Under normal operating conditions it would be unusual to trigger 
this alarm.
Consequently the term High is not as extreme as High High and is normally set a small 
distance below the High High limit.
The term Low Low is normally associated with the extreme lower limit to which a tank 
would be emptied. Under normal operating conditions it would be unusual to trigger 
this alarm.
Consequently the term Low is not as extreme as Low Low and is normally set a small 
distance above the Low Low limit.
Clearly it is essential that all the alarms being used are configured correctly.

The programmable level alarms have equivalent gauge alarms. The programmable alarms 
would normally be set slightly below and slightly above there respective gauge alarm values. 
The programmable alarms would normally be used as early warnings to the gauge alarms.
However the user can choose to use them as required although it is recommended that they 
are used within the context of the definition of the alarm to avoid confusion.
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Programmable Water Alarms

BA00390GEN_0186

Water alarms are triggered when tank water levels exceed the limits specified. If you do not 
require a low water alarm, set the low level to a negative value.

• High Water Level - an operator configurable free water level, above which the alarm will 
be triggered.

• Low Water Level - an operator configurable free water level, below which the alarm will 
be triggered - If a low water warning is not required set this to a negative value, to prevent 
it occurring.
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Floating Roof Alarm

BA00390GEN_0187

The purpose of the Floating Roof alarm is to provide the operator with the option of 
generating a warning when the product level starts to approach the point where the roof 
starts to rest on its legs. Under normal operating conditions this is generally undesirable; 
therefore the alarm has been provided for that purpose.

• Enabled - when selected, the Floating Roof Alarm will be activated when the product level 
falls below the Roof Early Warning Level. The alarm will be cleared when the product level 
rises above the Roof Early Warning Level by more than the Roof Warning Hysteresis.

• Roof Early Warning - an operator configurable set point determining at what level the 
alarm will be generated. The level would normally be programmed above the Roof Fully 
Floating level set in the configuration tool.

• Roof Warning Hysteresis - the operator configurable distance by which the product level 
must return above the Roof Early Warning Level in order to clear the Roof Early Warning 
Alarm.
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Programmable Temperature Alarms

BA00390GEN_0188

These are operator programmable temperature alarms.

• High - an operator configurable high temperature alarm.
• Low - an operator configurable low temperature alarm.
• Hysteresis - an operator configurable temperature hysteresis.
• Enabled - an operator configurable temperature alarm enable.
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Density Alarms

BA00390GEN_0189

These are operator programmable density alarms.

• High - an operator configurable high density alarm.
• Low - an operator configurable low density alarm.
• Hysteresis - an operator configurable density hysteresis.
• Enabled - enables and disables the alarm
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8.4.2 Modifying Data within Alarm Configuration
To modify data within the Alarm Configuration module, proceed as follows:

Select the tank to be modified from the list and the type of alarm to be modified.
The current details for the alarm for that tank will be displayed.

Take note that if this is the first time Alarm Configuration has been loaded after 
installing the system it will be displaying default values. It is essential that default 
values are replaced with the correct operating values.

Select the field to be edited and type in the new data values.

Each field is validated both during data entry and just before the data is saved to the 
database.
You can use the TAB key to move to the next entry field.

If the changes made are correct and you want to save them, press the Apply button to 
save the changes to the database.

To edit further tanks follow the same procedure.

If you want to abandon any changes made since the last time the Apply button was 
pressed, press the Cancel button.
This will also exit the application.

To exit the application, either close the Window or press the Cancel or OK buttons.

8.4.3 Generation of Alarms
Normally in a standalone configuration the alarms are detected and generated by the Data 
Communications Control module. It is this module that sees the changes in gauge data first.
In a client-server system it is the same module that detects and reports the alarms although 
it is important to note that this module will only be running on the server.
Any client connected to the server will therefore see the same alarms.
Some events may be generated locally by each client. These are normally events in response 
to abnormal operating data or transient or irrecoverable data access errors.

8.4.4 Enabling and Disabling Alarms
Enabling an alarm means that the variable associated with the alarm will be monitored 
against its set limits and when it deviates outside of those set limits an alarm will occur.
Disabling an alarm means that no alarm processing will take place for the disabled alarm and 
therefore no event, audible signal or otherwise will be generated if the variable goes outside 
of its set limits.

Alarms can generally be enabled or disabled in one of two ways:
• The alarm configuration display provides a check box within each tab for enabling or 

disabling the alarm.
• Alternatively, the pop-up menu allows the user to enable and disable the alarms.

The enabling and disabling of alarms is logged to the audit trail file.

1.

2.

3.

4.

5.
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8.5 User Defined Alarms
User Defined Alarms (Programmable) are a set of alarms which the user may configure 
based on a set point and hysteresis. There are eight alarms User Defined Alarm One to User 
Defined Alarm Eight.

BA00390GEN_0190

There is a drop down box to select the alarm type and a text box to enter the alarm 
description.
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BA00390GEN_0191

The text that is displayed when the alarm is activated or cleared and the severity is set in 
Event Server Configuration.

BA00390GEN_0072
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8.6 User Defined Alarms (Gauge)
User Defined Alarms (Gauge) are a set of alarms generated by certain gauge types, Bit 
pattern data is received by the application from a Modbus or OPC host which must be 
configured in DCC (see DCC config document). The user may configure the text to be 
displayed when the alarm is activated and cleared. There are 32 such alarms per gauge:

• User Defined Alarm 1
• User Defined Alarm 2
• User Defined Alarm 3
• Etc. etc. up to;
• User Defined Alarm 32

The alarms are available in the database for all gauge types which support Modbus or OPC.
To configure the text and severity, display the Events page of the Event Server 
Configuration utility.

BA00390GEN_0073

From this page the settings for each alarm in the system can be defined.

To show the settings select the alarm from the list.

The user defined alarms are:
• User Defined Alarm 1
• User Defined Alarm 1 Cleared
• User Defined Alarm 2
• User Defined Alarm 2 Cleared
• User Defined Alarm 3
• User Defined Alarm 3 Cleared
• Etc. etc. up to;
• User Defined Alarm 32
• User Defined Alarm 32 Cleared

The On and Cleared parameters define what text is displayed when the alarm is activated 
and cleared. These should be modified by the user to the required text.

1.
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The severity may be set by the user as required.
The Event Server should be re-started to load any new alarm definitions. Use the service 
manager utility to do this.
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9 Product Configuration
When first installed, the system has no product information.
This function is used to enter the names of the products stored on-site.
Product Configuration can be launched at any time in order to edit and modify existing 
products as well as add new products or delete existing products.
Each product needs to be allocated to a product type. By default, a GENERAL product type 
exists. Other product types can be created using this function.

The use of this feature can be controlled by the security system.

9.1 Product Types
Product Types allow the user to group products that have similar characteristics.

For example, general product types might be configured as:
• DISTILLATES
• SPIRITS
• CRUDE
• HEAVY OILS
• FUEL OIL

The following products may for example be members of the DISTILLATES product type:
• DERV
• KERO
• GAS
• OIL
• JET A1

Similarly, the following products may be members of the SPIRITS product type:
• ULMS
• LRP
• UL 95
• UL 98

And so on.

The system provides features that allow the user to view tanks by product type.
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9.2 Launching Product Configuration
To launch the Product Configuration module, proceed as follows:

Select the Product Configuration option from the Configuration menu.

BA00390GEN_0300

The details of the product or product type selected from the list are displayed in the right-
hand pane.
A filter has been provided, as shown in the figure below. This can be useful for locating a 
particular product when a large number of products have been configured. To filter the 
products, type the filter criteria into the text box in the tool bar. Any products whose name 
contains the filter text will be displayed. There is an indication of the number of products 
included in the filter shown in the product/product type list and also on the product type 
details pane.

1.
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9.2.1 Creating a Product Type
To create a product type, proceed as follows:

Click on the New Product Type  tool bar button.

Enter a name for the product type.

Click Apply or OK to save the new configuration. 
Alternatively click on any entry in the product/product type list with the right mouse 
button and select New Product Type from the menu

BA00390GEN_0195

The new product type will be created and inserted into the list.

9.2.2 Modifying a Product Type
The only item that can be modified for a product type is the name. To modify the name, 
proceed as follows:

Select the product type from the list of product types. 
The existing details will be displayed in the right hand pane.

Edit the name as required and click Apply or OK to save the new name. 
The version number will automatically increment.

1.

2.

3.

1.

2.
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9.2.3 Delete Product Type
Product types that contain products cannot be deleted. Attempting to delete a product type 
which contains products will result in the following error message.

BA00390GEN_0196

In order to delete a product type, all products within the product type must first be 
deleted or moved to a different location.

To delete a product type, proceed as follows:

Select it from the list of product types and click the Delete  tool bar button.

Confirm that the product type is to be deleted in the pop up.

BA00390GEN_0198

The GENERAL product type cannot be deleted.

9.2.4 Creating a New Product
To create a new product, proceed as follows:

Select the product type that will contain the product and click on the New Product  
tool bar button.

Enter a name for the product, select a colour to represent the product and, optionally, 
add a product code (up to 8 characters) and a description.

Click Apply or OK to save the configuration. 
The new product will be created and inserted into the list under the currently selected 
product type.

The use of colour is determined by options configured in the System Settings module. 
Please refer to this section for a description of these settings (→ ä 96).

Alternatively click on any product type, or entry within the product type, with the right 
mouse button and select New Product from the menu to create a new product in the selected 
product type.

BA00390GEN_0200
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9.2.5 Modifying a Product
To modify a product, proceed as follows:

Select the product from the list. The existing details for the product will be displayed in 
the right hand pane. The name, colour and description for the product can then be 
modified.

A product can also have a set of characteristics configured which will override the 
corresponding settings in the configuration tool which will then appear grayed out and will 
be fixed for use with the selected product. This is not an exhaustive set of characteristics and 
should not be considered an alternative to configuring characteristics for individual tanks. It 
is, however, useful for fixing a set of characteristics for a particular product.

To add characteristics select the product and then click the Add Characteristics  tool 
bar button. If a product already has characteristics, then the toolbar button is displayed 
differently  and can be used to remove the characteristics.

If characteristics are removed they will then need to be set on each tank containing the 
product.

A product which has characteristics set can be expanded to show additional entries:

BA00390GEN_0203

Select the entry to show the settings available for each heading:

BA00390GEN_0302

Refer to the section on the configuration tool (→ ä 23) for more details on these settings.

Click the Apply or OK button to save the settings. 

9.2.6 Deleting a Product
To delete a product, proceed as follows:

Select the product from the list and click the Delete  tool bar button.

Confirm the product is to be deleted in the pop up.

1.
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The Empty product is required as the default when creating new tanks so cannot be 
deleted, also products which are currently allocated to a tank cannot be deleted.

9.2.7 Relocating a Product
To relocate a product, proceed as follows:

To move a product from one product type to another it can either be dragged with the 
mouse from its current product type to the new product type, or it can be clicked with 
the right mouse button and the new product type selected from the menu.

BA00390GEN_0208

9.2.8 Displaying Product Codes
Products may be selected using either Product Names or Product Codes.
To change between names and codes, proceed as follows:

Click on the toggle (  /  ) button in the Product Configuration menu bar. This will 
affect product selection in the configuration tool, on the Home page and in the SCADA 
screens.

9.2.9 Saving Changes
To save changes made to products and/or product types, proceed as follows:

Click either the Apply or OK button.

Clicking Apply will save the changes and keep the product configuration screen open 
allowing for further editing. 
Clicking OK will save the changes and then close the product configuration screen.

If a product with characteristics has been modified, then any characteristics of the 
product will be applied to all the tanks that have that product allocated when the 
product changes are saved.

9.2.10 Discarding Changes
To discard any changes made, proceed as follows:

Click the Cancel button. 
The following message will be displayed if there are any unsaved changes.

1.

1.

1.

1.
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9.3 Allocating Products to Tanks
Once all the product information has been entered the products can then be allocated to 
their operational tanks.
The Configurator tool module is used to allocate a product to a tank.
See the section detailing the Configurator tool module for a full and complete description 
(→ ä 23).
Alternatively, the product allocated to a tank can be changed from the Home Page, Single 
Tank Overview and SCADA screens. See the relevant sections in the Operations Manual for 
more details.
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10 Security
The application is provided with its own security and user administration functions. It is not 
dependent on Windows system security for access to its features.
The tank gauging applications check that the current user has access privileges for the 
features in the module by communicating with the Security Manager running in their 
Windows session. This in turn communicates with the Security Service on the Tank Gauging 
server, if the system is a standalone one, then the service will be running in the background 
on the same machine, otherwise it may be running on a remote server over the local area 
network. This service stores the security information in a database called "TGSecurity" on the 
server. The figure below represents this architecture.

BA00390GEN_0269

When troubleshooting security problems it is important to consider all the pieces in the 
security system, the problem might lie in the communications between the Security 
Manager on the client and the Security Service on the server, or with the connection between 
the Security Service and the database.

Redundant Systems
If your system is a redundant one there are instances of the Security Service running on both 
servers, each system also has a copy of the TGSecurity database. In normal operation when 
both servers are available Security Manager will communicate with one of the servers: there 
is no way to determine which server the Security Manager is using, nor is there a way to 
command the Security Manager to connect to a particular server.
In the event that one of the servers fails, the Security Manager will connect to whichever of 
the servers it can. While in the failed state users can continue to log in and out of the system 
and features such as automatic log out are maintained. However, in such a state, the security 
system will prevent security settings from changing, the alteration of users and groups and 
users changing their passwords. This is in order to preserve the synchronisation of the 
TGSecurity databases on the two systems.

Initial Set up
During initial installation an Administrative account is created as part of the Set-up 
procedure. Thereafter additional user accounts can be created by a user with administrative 
privileges.
The security maintenance features are accessed via the Security menu.
The security features should be used carefully to ensure users have the correct access rights 
for their day to day tasks yet prevent unauthorised access to the other features.
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10.1 Security Settings
In order to adjust the security settings, proceed as follows:

Log on to system as an administrator.

Select the Security Settings option from the Security menu.
The following screen appears:
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User Access rights (from User group) are only applied if Login Enabled.

Adjust the settings according to the explanations below.

Login Enabled

Determines whether the use of logins should be disabled throughout the whole application.
If this option is checked, the system will prompt for a User name and Password before 
providing access.
If this option is not enabled, no login prompt will appear.
Clearly this option needs to be treated with care.

Access rights when no user logged in

If Login is enabled, there is obviously a state when the user logs out or when the system 
starts up. You can assign a user group for this state and then define what actions the system 
will accept without a user being logged on. For instance you may allow users to change the 
arrangement of tanks on the screen without logging on, but require that users log in to 
acknowledge an alarm.

Audio Cues

Changes the way that users are informed of a need to log in.
• Voice: A spoken announcement is made, currently the only language spoken is English.
• Sound A simple beep noise is given.
• None: There is no audible indication of a need to log on.

Show pick list of user names on log in screen

Determines whether a pick list of user names is displayed on the log in screen instead of the 
user name text field. Use of this setting is not recommended since it reduces security.

Lock screen when no user is logged in

Determines whether the screen is locked when no user is logged in. If this option is ticked 
the screen is locked when the user logs out. Before anything can be accessed on the 
computer, a user must log in.

1.

2.

3.
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10.2 User Maintenance
In order to launch the User Maintenance module, proceed as follows:

Log on to system as an administrator.

Select the Maintain Users option from the Security menu.
The following dialog opens:

BA00390GEN_0077

10.2.1 View/Edit Details of an Existing User
To view/edit details of an existing user, select the user in the list. Details of the user will be 
displayed in the User Details area.
If you have access rights to edit users, the following details can be edited.

Name

The name of the user.

User Group

The user group that the user belongs to. It is the user group that determines the areas that 
the user has access to. To edit user groups click the Maintain button.

Disabled

Determines whether the log in for the user is disabled. This can be set explicitly on this 
screen, or automatically by the system depending on the user group when the user 
incorrectly enters their password. To re-enable this user, untick the box.

Force Password Change

Forces the user to change their password the next time that they log in. This can be used in 
conjunction with the Password button to reset their password, but force them to change it 
the next time they log in, so that the administrator doesn't know their password.

Password

Click this button to reset the password for the user:

1.

2.



Security Tankvision Professional NXA85, LMS NXA86B - System Configuration

92 Endress+Hauser

BA00390GEN_0211

10.2.2 Adding a New User
To add a new user, click the Add button. A new user will be added to the list and selected 
ready for editing.

10.2.3 Deleting a User
To delete a user, select them in the list and click the Remove button. If the user is currently 
logged in you will be unable to delete them.

10.2.4 Saving Changes
To save the changes to the users click the Apply button. To save the changes and close the 
screen click the OK button.

10.2.5 Discarding Changes
To discard the changes to the users click the Cancel button. This will discard the changes and 
close the screen.
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10.3 User Group Maintenance
To launch the User Group Maintenance module, proceed as follows:

Log on to system as an administrator.

Select the Maintain Users Groups option from the Security menu.
The following dialog opens:

BA00390GEN_0212

10.3.1 View/Edit Details of an Existing User Group
To view/edit details of an existing user group, select the user group in the list. Details of the 
user group will be displayed in the User Group Details area.
If you have access rights to edit user groups, the details can be edited.

Name

The name of the user group.

Automatically Log Out

Determines whether users belonging to the user group will automatically be logged out after 
a given period of inactivity.

Disable User Log In

Determines whether users belonging to the user group will have their accounts disabled if 
they incorrectly enter their password the specified number of times.

Force Password Change

Determines whether users belonging to the user group will be forced to change their 
password after the given number of days.

1.

2.
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Password Strength

Determines whether users belonging to the user group will be forced to use passwords of the 
given strength.

If this option is used, passwords are case sensitive, otherwise passwords are case 
insensitive.

Access rights

To view details of a specific access right click on the  button to the left of it. This will 
show further details:

BA00390GEN_0213

Access rights granted for a user group are indicated by a tick. To remove or grant an access 
right click on the box next to it. This will toggle whether it is granted to the user group. 
Clicking on a ‘parent’ access right (for example System Settings above) will remove or grant 
access to all the options underneath it. So, for example, to prevent a user accessing the 
System Settings area, you could untick the box next to System Settings and this would 
remove the ticks from the Read and Modify boxes underneath it. 

BA00390GEN_0214

If the access rights under a ‘parent’ access right are in a mixed state (some ticked and some 
unticked), the box for the ‘parent’ access right will be filled in:

BA00390GEN_0215

User Access rights (from User group) are only applied if Login Enabled.

10.3.2 Adding a New User Group
To add a new user group, click the Add button. A new user group will be added to the list and 
selected ready for editing.

10.3.3 Copying a New User Group
A new user group can be copied from an existing one, to make setting up access rights easier. 
Select an existing user group and then click the Copy button. A new user group will be added 
to the list, with the same details as the existing user group, and selected ready for editing.

10.3.4 Deleting a User Group
To delete a user group, select it in the list and click the Remove button. If any users are a 
member of the user group you will be unable to delete it.

10.3.5 Saving Changes
To save the changes to the user groups click the Apply button. To save the changes and close 
the screen click the OK button.



Tankvision Professional NXA85, LMS NXA86B - System Configuration Security

Endress+Hauser 95

10.3.6 Discarding Changes
To discard the changes to the user groups click the Cancel button. This will discard the 
changes and close the screen.
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11 System Settings
System Settings affect the operation of the entire system. The System Settings option is 
available under the Admin menu.

The use of this feature can be controlled by the security system.

11.1 Using System Settings
To launch the System settings module, proceed as follows:

Select the Admin → System Settings option from the main menu bar.

BA00390GEN_0303

To change system settings, proceed as follows:

Enter the required data or change the current settings. For the meaning of the individual 
items refer to the explanations below.

Press the OK button.
The window will close and the changes will be saved to the database.

11.2 Default Tank Manual Data
Determines which data items will be set to manual status by default.
Selecting a data item in this section will force the corresponding item to be set to manual 
status by default when a new device is added to the system.

11.3 Ambient Conditions
These settings influence the hybrid-hydrostatic and hydrostatic calculations, and permit 
adjustment of the constants in these calculations to match the local conditions.

11.3.1 Local Gravitational Acceleration
The acceleration due to gravity expressed in m/s². Default: 9.8126 m/s².

11.3.2 Ambient Air density
The density of air at the site’s location expressed in the density units prevalent to the local 
system. Default: 1.23 kg/m³.

1.

1.

2.
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11.3.3 Water Density
The density of water typically found suspended in the products in the tank, expressed in the 
density units prevalent to the local system. Default: 999.02 kg/m³.

11.4 Security Settings

11.4.1 Use User Profile
Determines whether a user profile should be used. The user profile is limited to determining 
which tanks can be viewed by a user.

• When checked the user will be asked to logon at start-up on the assumption that the user 
only has access to a limited number of tanks programmed into the system. If the user has 
not been previously configured with a group of tanks no tanks will be in view at start up.

• When not checked the system will be started with the default profile which is show all 
tanks programmed into the system.

See the Tanks By User feature on how to configure a user profile.

11.4.2 Automatically Generate Unauthorised Movements
Determines whether the movements subsystem should enable and disable the unauthorised 
movement alarm.
If this option is checked the movements subsystem will disable the unauthorised movement 
alarm when a movement is opened for a tank. Similarly the movements subsystem will re-
enable the unauthorized movement alarm when a movement is closed and there are no 
more open movements for a tank.

11.5 Calculations

11.5.1 Flow Rate
The flow rate calculation can be made to mimic an MDP system.

11.6 Tank Settings

11.6.1 Use Product Colour
Determines the strategy for use of colour in the tank windows.
When selected the colour representing the product level in the tank will be that which was 
selected for the product in the tank. See the Configuration → Product Configuration 
options which allows the user to configure the colour a product will be displayed in.
When not selected the colour of the tanks is represented by the tank status. For example, if 
the tank is filling the colour of the product is displayed in blue, if the tank is emptying the 
colour of the product is displayed in brown, and if the tank is static the colour is displayed in 
green.

11.6.2 Movement Threshold
Determines the minimum level flow rate that is deemed significant enough to mark a tank 
as moving.
A flow rate of 5 mm/min is correct for most installations, but if your particular site has a lot 
of large crude tanks, for instance, you might want to use a smaller value. The threshold level 
is used to drive the up and down arrows on the tank mimic screens on the main page.
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11.6.3 Display Target Levels
Determines if a target level is displayed in the homepage when using simple movements.

11.7 Manual Level Entry

11.7.1 Warn Against Manual Level Entry
Determines whether the user should be warned if they attempt to enter a manual level entry 
that would fall outside the normal operating range of the tank.
For example above the High High level or below the Low Low level.
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12 Auto Startup Configuration

12.1 Description
The Auto Startup configuration allows the user to start any application within the system 
when the PC is rebooted or restarted. This is useful after a power trip for example. Any other 
program on the PC can also be added via the browse option. There is an overall delay (to 
allow for the database and services to start) and each application can be further delayed 
separately. Parameters or arguments may be passed to any application on startup.

12.2 Launching
The Auto Startup Configuration is launched from the windows start menu.
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Windows start menu for Tankvision Professional

BA0xxxxGEN_Configuration_0001

Windows start menu for Tankvision LMS

The configuration window below is opened:
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Configuration window for Tankvision Professional
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BA0xxxxGEN_Configuration_0002

Configuration window for Tankvision LMS

12.3 Configuring
Any application from the tank gauging system can be selected.
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Applications for Tankvision Professional

BA0xxxxGEN_Configuration_0003

Applications for Tankvision LMS
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In the example shown above the main screen with multi tank view has been selected. The 
default delay is 30 seconds and no further delay has been added. The dialog for adding 
arguments or parameters is shown opened.
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In the example shown above a custom application has been added.
The default delay is 30 seconds and a further delay off 20 seconds has been added. The 
dialog for adding arguments or parameters is shown opened.
During start-up a count-down window is displayed.

BA00390GEN_0087
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13 Manual Data
Normally tank data is collected from the field instruments automatically.
Where primary data values are not available or no longer available due to a gauge fault, data 
values can be switched from automatic mode to manual mode.
When in manual mode the data values have to be provided by the operator.
Data that is in manual mode is normally displayed with green text on black background to 
signify that it is manual data. On reports is it normally prefixed with the letter M.
Where tanks are not fitted with gauges but they are still required on the system, the tank 
may be operated with all of its primary data values in manual mode. In this way at least the 
tank inventory is still calculated. 

Gauges that have both level and temperature in manual mode will not be polled by the 
communications layer.

Primary data values are those measurements made by the tank gauging instrument such as:
• Product Level
• Water Level
• Product Temperature
• Product Density
• Pressure

Traditionally, most gauges provide Product Level and Product Temperature measurement 
capability. It is quite common to find that the rest are entered as manual data.
More modern gauging instruments have the capability to measure water level, density and 
pressure automatically. In this case the values would be collected automatically.

The use of this feature can be controlled by the security system.

By default a manual value will not trigger a programmable alarm, DCC Host → Options 
→ Configure ticking the option for alarms on manual data will reverse this 
functionality.

13.1 Launching the Manual Data Entry Module
To launch the Manual Data Entry Module, proceed as follows:

Select from the main application window menu Configuration → Manual Data.
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The following display is typical.
A list of all tanks will be displayed on the left, together with the manual data entry fields for 
the selected tank.
By default a reduced set of the most common fields will be displayed.

1.



Tankvision Professional NXA85, LMS NXA86B - System Configuration Manual Data

Endress+Hauser 103

BA00390GEN_0305

To view the additional fields for a tank click on the advanced  button which will extend 
the display to show additional values as shown below.
By default any changes to the manual data for a tank will apply to ALL gauges on that tank.
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13.2 Entering Manual Data
To enter manual data, proceed as follows:

Select the required tank/gauge from the list.

Edit the value.

If the variable is not already in manual mode tick the Enabled tick box. When saved this 
will switch the value to manual mode.

After all required data has been entered, press the Apply button to save the changes to 
the database.

Any problems in writing the data to the database will be reported to the user via the 
Status bar of the display.

Press the Cancel button to discard any changes and exit the application.

1.

2.

3.

4.

5.
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13.3 Putting a Variable into Manual Mode
Manual data can be modified regardless of whether the value being modified is in manual 
mode or not. 
When a parameter is switched to manual mode, the current data stored in the manual value 
will be utilised. The inventory data will also be calculated using values that are in manual 
mode.

There are essentially two techniques to putting a parameter into manual mode:
• Checking the tick box adjacent to the parameter in the manual data entry module, or
• Selecting the Manual Data option from the pop-up menu on the tank graphic view (see 

below).
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Either method has the same effect.

If the pop-up menu is used, the current manual data will replace the automatic value. 
If the current manual values are incorrect you would need to use the Configuration → 
Manual Data module or select Manual Data → Manual Data from the pop up menu 
to update them.

13.4 Shortcut to Manual Data
When a parameter is set to manual mode, its data is displayed with blue text and black 
background colour. 

Double click the parameter in manual mode.
This will launch the manual data entry module for the selected tank.

1.
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14 Tanks by User
This function provides an administrator with the ability to configure which tanks a user login 
can view.
This is quite useful on larger multi-user systems where tank operations are split between 
different users, and a user may be responsible for looking after a specific set of tanks.

Select the Tanks By User option from the Admin menu.
The Tanks By User display will be loaded.
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This display comprises two list boxes. One list containing the currently configured users and 
the other the full list of tanks with the tanks currently assigned to the selected user 
highlighted.

14.1 Setting Tanks a User Can View
To set the tanks a user can view, proceed as follows:

Select the user from the list.
Any tanks currently allocated to that user will be highlighted. Highlight the tanks in the 
tanks list that the selected user is able to view.

Click the OK button to save the changes. Repeat this for each user.

To exit the screen without saving the changes click the Cancel button.

For Tanks by User to work Login Enabled must be selected in Security Settings.

1.

1.

2.

3.
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15 Trending Configuration
Trending configuration is done on a server or standalone station. It is accessed via the Service 
Manager in the Windows system tray. The display is a multi-tabbed dialog as shown below.

15.1 General Tab
This contains configuration options relating to the trending service and housekeeping of the 
trend files.
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Trend File Location

A directory where the trend files will be stored. This location is relative to the Application 
directory.

Update Interval

The interval at which the tank data is checked to see if it has changed.
The trend server analyses the live tank gauging data by polling the RTDB on a timer based 
trigger. This value is the number of seconds between successive poll triggers.

TCP Port

The TCP port to be used by clients to communicate with the trending service.

Automatically Delete Historical Trend Files

If this option is checked historical trend files will be deleted after the time specified below.

Delete Trend Files After

The age the files need to be before they are deleted, if this feature is enabled.

Raise Alarm When Disk Space is Getting Low

If this option is checked an alarm will be raised through the events subsystem when the 
available disk space falls below the defined threshold.
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Raise Alarm When Available Disk Space Falls Below

The available disk space below which an alarm is to be raised.

15.2 Threshold Tab
The Threshold tab allows the sensitivity of the trending to be modified. In order to reduce 
the volume of data written to disk and therefore the size of the dataset the service only 
writes data items when they have changed significantly from their previous value. The 
threshold of each type of field is defined in the service configuration individually and it is this 
threshold that determines when a value is written.

If we take level as an example, a threshold of 0 millimetres will result in every level reading 
from the gauges being written to disk, doing so means there are more data point records in 
the trend files and a commensurate increase in time spent writing the data and reading it 
again to display in the trending client. It is therefore recommended that thresholds of zero 
are not used. When deciding on a threshold setting; approach it from the aspect of selecting 
what accuracy you need for your historical data on the graphical displays, not from trying to 
determine exact inventory conditions on the site at any given time. The trending data from 
the tank gauging system is not intended to provide verifiable custody transfer information.

15.2.1 Quantised data
Conceptually the domain of values for a given tank parameter are divided into discrete 
quanta. Each value in the domain maps to a single quantum. When a tank parameter’s value 
changes so that the quantum the value maps to is different from the previous tank 
parameter’s quantum, then the trending service records a value in the trend file. The quanta 
are calculated as follows:
Q = value / ((treshhold * √2) + ε)

Observe the factor of √2, this included so as to render the volume of data collected 
compatible with earlier versions of the software before quanta.
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The threshold values can be overridden for individual tanks to allow for the different 
behavior of different products and/or tank shapes. To override the threshold values for a 
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tank click on the Add button and select the tank from the list of tanks displayed. The tank 
will then appear in the list of tanks. Ensure that the tank is highlighted and then amend the 
threshold values.
Similarly to remove the override for the tank ensure that it is highlighted in the list and then 
click on the Remove button.

15.3 Filter Tab
The Filter tab allows the data to be trended for each tank/gauge to be unique. By default all 
tanks, gauge duties and fields are trended.
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Only Trend Selected Tanks

If this option is checked, only the data for the tanks highlighted in the list of tanks will be 
trended. Otherwise the data for all of the tanks will be trended.

Trend Primary

If this option is checked, the data for the primary gauges will be trended.

Trend Secondary

This option will only be visible if one or more tanks in the system has a secondary gauge 
configured. If this option is checked, the data for the secondary gauges will be trended.

Trend Backup

This option will only be visible if one or more tanks in the system has a backup gauge 
configured. If this option is checked, the data for the backup gauges will be trended.

Trend Densitometer

This option will only be visible if one or more tanks in the system has a densitometer 
configured. If this option is checked, the data for the densitometers will be trended.
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Only Trend Selected Fields

If this option is checked, only the data for the fields highlighted in the list of fields will be 
trended. Otherwise all the fields in the list will be trended.

15.4 Advanced Filter
The Advanced Filter tab of the trending configuration screen allows trending options to be 
set for element temperatures and skin temperatures (if appropriate). By default, element 
temperatures and skin temperatures are not trended.
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To set the element temperatures and/or skin temperatures to be trended on all gauges click 
on the click here hyperlink in the description. This will display the following screen:
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Highlight the element temperatures and skin temperatures to be trended and click the OK 
button. Note that this will overwrite the existing selected element temperatures and skin 
temperatures for all gauges.
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To set the element temperatures and skin temperatures to be trended for an individual tank, 
double-click the tank in the tanks list. If the tank has multiple gauges, double-click the gauge 
for which the element temperature and skin temperatures are to be trended. If the element 
temperatures can be trended for a gauge, the entry Element Temperatures will appear 
under the gauge. Similarly if the skin temperatures can be trended for a gauge, the entry 
Skin Temperatures will appear under the gauge. Select either Element Temperatures or 
Skin Temperatures and the list on the right hand side of the screen will be populated with 
the element temperatures or skin temperatures respectively. The temperatures to be 
trended will be highlighted. To modify the temperatures to be trended, highlight the 
temperatures to be trended.

15.5 Monitoring Alarms
The Monitoring Alarms tab of the trending configuration screen is used to configure and 
Enable/Disable the various trending alarms.
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General Settings

• Trend process poll period - The frequency, in seconds, that the trend service is polled to 
check the status of the alarm conditions.

• Trend process system startup hold-off - The delay, in seconds, after the system starts to 
allow the Trend service to stabilize. No alarms are raised during this time.

Not Running
If the Trending Service is not running no trend data will be generated. If enabled a "Trending 
Service not running" alarm will be raised in the Alarm Event Viewer. The following items are 
configurable:

• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops running for the specified time (Poll period × Absence Count).
If this option is not checked none of the alarms will be enabled and it will not be possible 
to configure any "count" or "hysteresis" values.

• Absence Count – Use this option to set the number of successive polls that must not detect 
that the trending service is running before an alarm is raised.

• Absence Hysteresis - Use this option to set the number of successive polls that must 
detect a running trending service before an alarm is cleared.

Not Responding
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If the Trending Service stops responding to requests there will be a loss of "Real Time" 
trending data, "Historic" trend data may still be generated. If enabled a "Trending Service not 
responding" alarm will be raised in the Alarm Event Viewer. The following items are 
configurable:

• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops running for the specified time
(Poll period × No Response Count).

• No Response Count - Use this option to set the number of successive polls that must not 
detect a response from the trending service before an alarm is raised.

• No Response Hysteresis - Use this option to set the number of successive polls that must 
detect a response from the trending service before an alarm is cleared.

Not Recording
If the Trending Service stops recording there will be a loss of "Historic" trend data, "Real Time" 
trending data may still be available. If enabled a "Trending Service not recording" alarm will 
be raised in the Alarm Event Viewer. The following items are configurable:

• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops recording for the specified time
(Poll period × Not Recording Count).

• Not Recording Count - Use this option to set the number of successive polls that must not 
detect the trending service is recording before an alarm is raised.

• Not Recording Hysteresis - Use this option to set the number of successive polls that must 
detect that the trending service is recording before an alarm is cleared.
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16 Device Command Scheduler
The Device Command Scheduler is a Windows service that can be configured to send device 
commands at a specific time of day on a recurring basis.
The Device Commands can be sent to a Single Tank, all Tanks, or a group of tanks generally 
specified by Gauge Type or Tank Group.
Care should be exercised when scheduling device commands, particularly those that affect a 
gauges primary measuring capability, as the tank may be involved in some sort of critical 
operation such as receiving product from a ship or similar.

16.1 Launching the Device Command Scheduler
The Windows service part of the scheduler, which sends the commands at the scheduled 
time, automatically starts up when Windows boots. The service can be monitored, as with all 
Windows services via the control panel, or using the application Service Manager, which is 
present as an icon in the system tray.

16.2 Configuring Scheduled Commands
The schedule by which the commands are executed is configured from the Command 
Scheduler GUI.
To configure scheduled commands, proceed as follows:

Right click on the Service Manager icon in the Windows system tray:
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Select Device Command Service → Device Command Config.
This will bring up the configuration application, which you can use to view and edit the 
scheduled commands.
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Select a scheduled entry from the list on the left of the window or create a new entry by 
clicking the New button.

1.

2.

3.
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You can also delete an entry from the database by selecting it from the list and clicking 
the Delete button.

Adjust the parameters according to the explanations below (→ ä 114).

Click Save to commit the changes to the database, or Cancel to discard them.

Scheduled entries are listed on the left of the window, selecting one of these entries will 
display the details of the entry in the controls on the right.

16.2.1 Scheduled Commands Parameters

Destination

Denotes the way the gauges can be selected for scheduling, either by a specific Tank ID, or 
collectively by Product Group Name, or by Product or by Gauge Type.

Gauge Duty

Where tanks are fitted with more than one gauge, you can specify which gauge on the tank 
is to perform the command.

Command

Sets the command to be executed by the gauge or gauges.

Custom Command

Enables you to configure a custom command.

Schedule

A scheduled command can be configured to send a series of commands between two 
specified times and a specified frequency. For example to send a command every hour 
between the hours of 01:00 and 04:00 you would set the start time as 01:00, the stop time 
04:00 and the interval as 01:00.

When you make changes to the schedule's detail, click Save to commit the changes to 
the database, or Cancel to discard them.
Clicking New will clear the currently selected entry's details, allowing you configure a 
new one. Clicking Save commits the entry to the database.
Delete will remove the currently selected entry from the database.

4.

5.
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17 Report Scheduler
The report scheduler facilitates the printing and exporting of reports and report documents 
in various formats at defined moments in time.

The report scheduler consists of 2 independent components:
• A background Report Scheduler Windows Service which executes the reports at the 

appropriate time(s).
• The Report Scheduler Configuration tool, used for configuring the reports.

The report configuration data is held in the file ReportSchedulerConfig.xml located in the 
same directory as the ReportSchedulerService.exe service executable.
This file is used by both of the above components. The configuration tool is used to edit the 
contents of the file for the desired user configuration. The service then loads this file to 
determine its actions.

17.1 Report Scheduler Service
The Report Scheduler service runs automatically as a Windows service, executing all 
scheduled reports at the appropriate times. It will run in the background and has no user 
interface.
The service will start automatically whenever the computer is rebooted and should therefore 
always be running.
The status of the service can be viewed by right clicking on the Tank Gauging Service 
Manager icon in the system tray and selecting the Report Scheduler Service item from the 
pop-up menu.
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The service may also be started or stopped using this menu.

17.2 Spooling of Scheduled Reports
Reports that are printed by the service are spooled to a directory where they are stored for a 
period of seven days before being deleted. This enables an administrator to obtain any time 
critical reports that have failed to print for any reason.
The location of the spool directory can be specified by the user by using the configuration 
tool to change the Spool Directory settings of the Area component.
Spooling does not occur if the reports are printed directly from the configuration tool.
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17.3 Report Scheduler Configuration
The Report Scheduler Configuration tool allows the user to configure the reports and report 
documents for a system.
To configure the report scheduler, proceed as follows:

Right click on the Tank Gauging Service Manager icon in the system tray.

Select the Report Scheduler Config item from the Report Scheduler Service menu:
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The following window opens:
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From the tree on the left select the component you are going to edit.
The tree view control on the left hand side of the configuration tool represents the 
components which exist on the system. 

The following types of components can appear in the tree view:
• Areas
• Batches
• Reports
• Report Documents
• Triggers

The grid view adjacent to the tree view represents the settings for each of these components.
For a description of these types of components refer to the sections below.

Enter the required values into the grid view on the right.

1.

2.

3.
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Click Apply to confirm your changes or Cancel to discard them.

If all the necessary changes have been made, click OK to close the window.

Any changes which are made to the report scheduler configuration will only be written 
to the ReportSchedulerConfig.xml when the user hits OK or Apply. If the user hits 
Cancel all changes to the configuration will be lost.

17.3.1 Area Component

Icon_Area_Component

The reporting system is represented by the root component of the tree, called an Area.

Renaming an Area component

The Area component can be renamed to reflect the name of the site and/or system. To do 
so, right click on the Area component and select Rename.

The Transaction log

The Area component also defines settings which determine the location of the transaction 
log. The transaction log stores information about the execution of the reports that the 
system processes and any consequent abnormal operating conditions. Right click on the 
Area component and select Transaction Log to view the log using Wordpad.

The System Reports directory

Also defined by the Area component is the System Reports directory. This is the directory 
which contains the predefined reports associated with the tank automation system. Both the 
Transaction Log directory and the System Report directory are set to sensible defaults upon 
installation, but can be easily changed if necessary.

4.

5.
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17.3.2 Batch Component

Icon_Batch_Component

Report, Report Document and Trigger components are contained within Batches. An Area 
can contain one or more Batches. 
A Batch defines various settings which describe the printing/export behaviour of the Report 
and Report Document components that it contains.

Adding Batches

In order to add a Report or Trigger to the system, we must first add a Batch. Right click on 
the Area node and select Add Batch from the menu. This adds a Batch to the Area.

Renaming/deleting Batches

The Batch can be renamed if required by right clicking on the Batch and selecting Rename 
Batch from the menu. A batch can be deleted from the Area in a similar way.

Locking and Unlocking Batches

Batches can be locked to prevent unauthorized users from deleting or modifying them. In 
order for a user to be able to lock or unlock a batch that user must be granted 'Full' Report 
Scheduler privileges. Users with 'Modify' privileges will be able to create, delete and maintain 
unlocked batches, but they won't be able to remove or place a lock on a batch.
In order to lock a batch, right-click on an unlocked batch and choose Lock Batch from the 
context menu, the unlocking process is similar except you choose Unlock Batch instead. A 
locked batch can't be altered - it must be unlocked in order to be amended.
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Locked batches can be identified by the lock icon superimposed over the top of the filing 
cabinet icon.
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17.3.3 Batch Print Settings
Click on Batch Print Settings to change the following parameters:
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• Default Printer - The default printer for report printing. Select from all installed printers 
in the drop down list. The list reflects the users installed printers only. 
[see: Start → Settings → Printers]]

• Secondary Printer - The secondary printer is used for printing if the default printer is 
unavailable.

In both cases the printer must be a real printer, not a print to file device as the service 
does not interact with the console.

1.
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17.3.4 Batch Export Settings
Click on Batch Export Settings to change the following parameters:
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• Export Type – The format of the exported report. Select from all available formats in the 
drop down list including .rpt, .xls, .pdf, .rtf and .doc.

• Export to disk – Path to folder which will contain the exported report. Blank entry disables 
disk export.

• Export to email – Semicolon separated list of email addresses to which the report will be 
sent. Blank entry disables email export. (Users require an SMTP mail server to use this 
feature; the server itself is specified as an Area setting.)

• Sender E-Mail Address – The address that will appear in the ’From’ field of received E-
mails.

• Subject – Enter the text that will appear in the ’Subject’ field of received E-mails.

1.
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17.3.5 Batch FTP Export Settings
Click on Batch FTP Export Settings to change the following parameters:

BA00390GEN_0244

• Ftp Server Name – The full name used to identify the ftp server. Blank entry disables ftp 
export.

• Ftp Username – User-name used to log-on to the ftp server.
• Ftp Password – Password associated with ftp user-name.
• Ftp Path – The path to the drop directory on the Ftp server.

1.
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17.3.6 Report Component

Icon_Report_Comment

A Batch can contain one or more Report components each of which represents a Crystal 
Reports format report file. 
To add a Report to a Batch, right click the Batch, select Add Report and select a .rpt file using 
the 'Open File' dialog box displayed. 
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To remove a Report from a Batch, right click on it and select Delete Report.

A Report defines the following settings which describes the Reports individual behaviour 
independent of it's parent Batch settings:

General Settings

• Print Enabled
Printing enabled for this report.

• Export Enabled
Export enabled for this report.

• Date Stamp Export
If True, add the date to the file-name for the exported file.

• Time Stamp Export
If True, add the time to the file-name for the exported report.

Database Settings

• Data Source Name
Specify the ODBC data source name.

• Database Name
The name of the database used to generate the report.

• User ID
The user name used to log-on to the database. The default is 'sa'.

• Password
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The password associated with the User ID. The default is blank.

Parameter Settings

This section is auto-generated from the report itself. If the report gives the user the option 
of specifying parameters they can be entered here. The default values for each field are 
shown in a combo box if any are specified.

17.3.7 Report Document Component

Icon_Word

Icon_Excel

A Batch can contain one or more Report Document components. Each Report Document 
component represents a Word document or an Excel Workbook which conveys report data.
Report and Report Document components can happily co-exist within the same Batch.
To add a Report Document to a Batch, right click on the Batch, select Add Report Document 
and select a .doc or .xls file using the Open File dialog box displayed. To remove a Report 
Document from a Batch, right click on it and select Delete Report.

In order to use Report Document components within the Report Scheduler, Microsoft 
Office 2003 or later must be installed.
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17.3.8 Trigger Component

Icon_Trigger

A batch can also contain one or more Triggers. A Trigger is a component which specifies 
when a Batch will run, and hence when all of its Report modules will run. Right mouse click 
on the Batch component to see the trigger options as shown below.
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There are 6 types of Triggers:

1. Interval Trigger
A trigger which is fired every time interval, defined in hours and minutes. A 
synchronization time may also be defined, from which all interval timings will be based.

2. Hourly Trigger
A trigger which is fired at a specified number of minutes past every hour.

3. Daily Trigger
A trigger which is fired at a specified hour every day.

4. Weekly Trigger
A trigger which is fired on a specified day of the week, at a specified hour.

5. Monthly Trigger
A trigger which is fired on a specified day of the month, at a specified hour.

6. Run Once Trigger
A trigger which is fired once only at a specified time.

By adding Triggers to Batches it is easy to build up complex scheduling. For example, if it is 
required that a Batch is run three times a week, add 3 Weekly Triggers to a Batch, specifying 
a different firing day for each.

To add a Trigger to a Batch, right click on the Batch, select Add Trigger and select the 
trigger type from the sub-menu.
To remove a Trigger from a Batch, right click on it and select Delete Trigger.
You can also specify a period of time over which a trigger will be active on the Trigger 
Period Settings page.
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17.3.9 View, Print and Export Reports
It is possible to print, export or view a Report or Report Document directly from the GUI 
rather than relying upon Triggers and the service component.

Right click on the relevant component and select Print, Export or View from the menu.
The configuration is automatically saved should any of these commands be used.
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Any changes which are made to the report scheduler configuration will only be written 
to the ReportSchedulerConfig.xml when the user selects OK or Apply. If the user 
selects Cancel all changes to the configuration will be lost.

1.
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18 Messaging

18.1 Message Service
The messaging service is used to queue and distribute messages asynchronously.  Messages 
can be sent to:

• E-mail clients (SMTP mail server required).
• Mobile telephones in the form of SMS messages (GSM modem required).
• Telephones (voice modem required).
• Site Radios (specialist hardware required).

The messaging service configuration is accessed from the application Service Manager icon 
in the Windows system tray.
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Click right on this icon.

Select Messaging Service → Messaging Service Config.

This will bring up the configuration application, which you can use to view and edit the 
messaging configuration.
This application contains the following pages:
• General
• E-Mail
• SMS (if the SMS Messaging option has been licensed)
• Telephone (if the Telephone Messaging option has been licensed)
• Radio (if the Radio Messaging option has been licensed)

1.

2.
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18.1.1 General
The general page allows configuration of settings relating to the messaging service as a 
whole:
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TCP Port

The TCP port which is used to accept messages from client applications. This must match the 
TCP port configured in the messaging client configuration file.

Interval

The interval in milliseconds at which the service will check for incoming messages.

Logging

The level of logging required. This is used for diagnostic purposes if there are problems with 
the messaging service. Generally it should be set to Off.

Log Path

The path to the log file.
The current log file can be viewed by clicking on the View Log button, or deleted by clicking 
on the Delete Log button.
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18.1.2 E-Mail Configuration
The E-Mail page allows configuration of settings relating to sending e-mails:
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SMTP Server

The SMTP server to be used to send e-mails from the messaging service. (User name and 
Password valid for the domain are required for external emails.)

SMTP Port

The port used by the messaging service to connect to the SMTP server.

Send Attempts

The maximum number of times a message should be sent to the SMTP server if it fails for 
any reason on a preceding attempt.

Send Retry Delay

The interval to wait before attempting to resend a message to the SMTP server following a 
failure.

Logging

The level of logging required. This is used for diagnostic purposes if there are problems with 
the e-mail part of the messaging service. Generally it should be set to Off.
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18.1.3 SMS Configuration
The SMS page allows configuration of settings relating to sending SMS messages. It will only 
be present if the SMS Messaging option has been licensed:
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Serial Port

The serial port to which the GSM modem to be used to send SMS messages is attached.

Send Attempts

The maximum number of times to attempt to send a message via SMS.

Retry Interval

The interval to wait before attempting to resend a message following a failure.

Send Order

Indicates whether messages are to be sent in priority order, or in the order in which they 
were received from clients.

Logging

The level of logging required. This is used for diagnostic purposes if there are problems with 
the SMS part of the messaging service. Generally it should be set to Off.
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18.1.4 Telephone Configuration
The Telephone page allows configuration of settings relating to sending voice messages to a 
telephone. It will be present only if the Telephone Messaging option has been licensed.
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Serial Port

The serial port to which the modem used to send voice messages is attached. The modem 
must be a voice modem. To check if the modem is compatible with the messaging service, 
open HyperTerminal and connect to the modem as a serial device. Then type AT+FCLASS=?. 
The response should be in the form 0,1,8,80 (followed by OK). This list of supported classes 
must contain 8 for the modem to be used to transmit voice messages.

Send Attempts

The maximum number of times to attempt to send a message to a telephone.

Retry Interval

The interval to wait before attempting to resend a message following a failure.

Send Order

The order in which messages are to be transmitted.

Outside Line

Some locations require a number to be dialed to access an outside line. If this is the case, 
enter the number in this field.

Logging

The level of logging required. This is used for diagnostic purposes if there are problems with 
the telephone part of the messaging service. Generally it should be set to Off.
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18.1.5 Radio Configuration
The Radio page allows configuration of settings relating to broadcasting messages over a 
radio network. It will be present only if the Radio Messaging option has been licensed.
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Adding a radio network

To add a new radio network click the Add button. The settings screen is displayed 
(→ ä 133).

Removing a radio network

To delete an existing radio network select it from the list and the click the Remove button.

Editing a radio network

To edit an existing radio network select it from the list and then click the Properties button. 
The settings screen is displayed (→ ä 133).

Testing a radio network

To broadcast a test message, proceed as follows:

Click the Test button.
The following screen will be displayed:
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1.
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Configure the test message to be broadcast (for more details → ä 137).

Click the Test button.
If the radio network has been configured correctly the message should be broadcast over 
the site radio. The status of the relay board inputs and outputs should be indicated 
correctly during the broadcast. The status of the inputs and outputs can be used to 
determine the configuration issues if the message fails to broadcast.

2.

3.
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18.1.6 Radio Settings

Radio Settings - Radio

The Radio page allows the basic configuration details for a site radio to be set up.
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• Name – The name used to identify this radio configuration.
• Playback Device – The playback device on the PC which will be used to generated the 

audio to be broadcast over the radio. It is strongly recommended that this is not the default 
playback device for the PC, since that might lead to other audio output from the PC being 
inadvertently broadcast over the radio.

• Radio Type – There are three possible types of radio configuration – simple, standard or 
trunking. The difference lies in the way that the COR (Carrier On Relay) input is handled. 
For simple radio systems the COR input is ignored and the message is broadcast 
immediately, ignoring any other transmissions in progress.

• Relay Board – The index of the relay board which is connected to the ROB (Radio Output 
Board) and optionally an alarm panel and/or manual reset switch.

• Output Channel – The index of the relay on the Arcom relay board which is connected to 
the PTT terminal of the radio output board.

• COR Channel – Not applicable for simple radios.  The index of the input on the relay board 
which is connected to the COR terminal of the radio output board.

• Radio channel is busy when COR is High/Low – Not applicable for simple radios. 
Indicates whether the radio channel is busy when the COR input is high or low. This may 
vary from base station to base station.

• COR Inactive Interval – Not applicable for simple radios. The number of seconds the COR 
input needs to be inactive before an attempt is made to broadcast a message.

• Wait Interval – Trunking radios only. The number of seconds to wait for the COR input to 
become inactive after PTT.

• Wait Retry Interval – Trunking radios only.  The number of seconds to wait before setting 
the PTT following the COR input failing to become inactive during a transmission attempt.
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Radio Settings - Messages

The Messages page allows message configuration details to be set up.
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• Default Repeat – The number of times a message is to be repeated by default unless it is 
specifically overridden.

• Default Repeat Interval – The length of time before a message is to be repeated.
• Gap – The length of time to be left before broadcasting the next message.
• Key Up Delay – The length of time between setting PTT and beginning to output the audio
• Key Down Delay – The length of time between completing the audio output and unsetting 

PTT.
• Prefix – A standard message to be prefixed to all broadcast messages. This can be used to 

add a standard call sign for example. To edit this message click the  button to the right 
of the field. See section on Configuring Audio Messages for more details (→ ä 137).

• Suffix – A standard message to be suffixed to all broadcast messages. This can be used to 
add a standard sign-off for example. To edit this message click the  button to the right 
of the field. See section on Configuring Audio Messages for more details (→ ä 137).

• Manual Clear Channel – The index of the input on the ArcCom relay board to which the 
manual reset switch is connected. If no manual reset switch is in use, this should be set to 
0.
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Radio Settings - Communications

The Communications page allows configuration of the communications failure 
functionality.
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• Check for Comms Failure – Indicates whether the messaging service is to check whether 
communications with calling applications is interrupted.

• Watchdog Interval – The interval defining what constitutes a communications failure.
• Message – The message to be broadcast when a communications failure is identified. To 

edit this message click the  button on the right side of the field. See section on 
Configuring Audio Messages for more details (→ ä 137).

• Repeat Interval – The interval at which the communications failure message is to be 
broadcast until communications with client applications is restored.



Messaging Tankvision Professional NXA85, LMS NXA86B - System Configuration

136 Endress+Hauser

Radio Settings - Health Check

The Health Check page allows configuration of the health check functionality.
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Health Check Channel – The index of the relay on the relay board which is connected to the 
health check terminal on the radio output board. If no health checking is to be performed, 
this should be set to 0.

Output Channel – The index of the relay on the relay board which is connected to an alarm 
indicator (such as an alarm panel). If no external alarm is being used, this should be set to 0.

Health check output channel is Active/Inactive when power is off – This field allows 
configuration of the default state of the external alarm indicator. This means that the system 
can be configured to display an external alarm if the PC is shut down.

Radio Test – This field allows a periodic test to be carried out to ensure that the audio output 
from the PC is reaching the radio output board. This can be one of the following values:

• Off - No test performed.
• On - The test message is broadcast over the radio if no message has been broadcast in the 

time defined in the Radio Test Interval field.
• On (Timed) - The test message is broadcast over the radio at intervals defined by the 

Radio Test Sync Time and Radio Test Interval fields irrespective of when the last 
message was broadcast over the radio.

• Silent - The audio message is to be transmitted to the radio output board if no message 
has been broadcast in the time defined in the Radio Test Interval field.However, PTT is 
not set so the message is not actually broadcast over the radio.

• Silent (Timed) - The audio message is to be transmitted to the radio output board at 
intervals defined by the Radio Test Sync Time and Radio Test Interval fields irrespective 
of when the last message was broadcast over the radio. However, PTT is not set so the 
message is not actually broadcast over the radio.

Message – The message to be broadcast. To edit this message click the  button on the 
right side of the field. See section on Configuring Audio Messages for more details 
(→ ä 137).
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18.2 Configuring Audio Messages
Configuring Audio Messages is a relatively simple process. However, in the interests of 
integrity and flexibility fields containing audio messages cannot be edited directly.
Throughout the system where a message field is used, it is read-only and has a  button 
next to it.

To edit the message click on the  button.
This will bring up a separate screen allowing editing of the message. Although these 
screens may differ in detail they will always contain the following fields:
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Adding a message element

To add a new message element click the Add button.

• Clicking on the arrow on the button will display a drop-down menu allowing selection of 
the element type:
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• Clicking on the main part of the button automatically selects the previous message 
element type (defaulting to Audio if no previous selection has been made).

A configuration screen for the message element will be displayed (→ ä 138, → ä 139).

Click the OK button on the configuration screen.
The message element is added to the message.

Editing a message element

To edit a message element, proceed as follows:

Select the message element in the list.

Click the Edit button. 
The relevant configuration screen for the message element will be displayed (→ ä 138, 
→ ä 139).

Click the OK button on the configuration screen.
The message element is updated.

1.

1.

2.

1.

2.

3.
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Removing a message element

To remove a message element, proceed as follows:

Select the message element in the list.

Click the Remove button.

Moving a message element up or down

To move a message element to earlier in the message, proceed as follows:

Select the message element in the list.

Click the Move Up button until the required position is reached.

To move a message element to later in the message, proceed as follows:

Select the message element in the list.

Click the Move Down button until the required position is reached.

18.2.1 Audio Element
The audio element simply plays an audio file as part of the message.

Select the audio file on the audio configuration screen.
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The audio files available to the messaging service are stored in a directory called Messaging 
Media which can be found under the directory that the messaging service is installed in.

Click the OK button.

18.2.2 Break Element
The Break element allows the insertion of a break between other message elements. The 
break can either be a pre-defined length, or explicitly specified.

1.

2.

1.

2.

1.

2.

1.

2.
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BA00390GEN_0159

To explicitly specify the length of a break, proceed as follows:

Select Timed from the drop-down list of break types.

Enter the duration of the break in milliseconds in the Duration field.

18.2.3 Text Element
The Text element allows the use of free format text which will be synthesized using the text 
to speech functionality of Windows.

The standard synthesized voice in Windows may seem rather robotic and it would 
usually be better to record messages and use the Audio element instead.
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1.
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Appendix

Appendix A – Standard for Calculation default flags

Industry standard Flag

IP • Roof weight specified in air
• Enable tank shell correction
• Use IP calculation of TOV/GOV
• Include suspended sediment & water
• Do not combine suspended sediment & water
• VCF is normal

API • Roof weight specified in air
• Enable tank shell correction
• WCF uses Table 56 calculation
• Use API calculation of TOV/GOV
• Include suspended sediment & water
• Combine suspended sediment & water
• Net values calculated from gross
• VCF is normal

GB/T • Roof weight specified in air
• Enable tank shell correction
• WCF uses fixed 0.0011 kg/l
• Use API calculation of TOV/GOV
• Include suspended sediment & water
• Combine suspended sediment & water
• Net values calculated from gross
• VCF is normal

GB/T direct weight • Roof weight specified in air
• Enable tank shell correction
• WCF uses fixed 0.0011 kg/l
• Use API calculation of TOV/GOV
• Include suspended sediment & water
• Combine suspended sediment & water
• Net values calculated from gross
• WCF uses short Table 56
• VCF is normal

GOST • Roof weight specified in Vacuum (mass)
• Use IP calculation of TOV/GOV
• Net values calculated from gross
• WCF uses short Table 56

JIS • Gauge reads reference density
• Roof weight specified in Vacuum (mass)
• WCF uses Table 56 calculation
• Use API calculation of TOV/GOV
• Disregard suspended sediment & water
• Water density 1.0 kg/l for fresh water
• Net values calculated from gross
• Tank shell is not insulated
• VCF is normal

JIS-MDP • Gauge reads reference density
• Roof weight specified in Vacuum (mass)
• WCF uses Table 56 calculation
• Use API calculation of TOV/GOV
• Disregard suspended sediment & water
• Water density 1.0 kg/l for fresh water
• Net values calculated from gross
• Tank shell is not insulated
• VCF is restricted
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Appendix B – Product Inventory Flags

Setting 1 (unset) Setting 2 (Set) Explanation

WCF uses Table 56 
correction

WCF uses fixed 0.0011 
kg/l

Select this to use a calculated WCF, which gives better 
accuracy when calculating WCF.

Use IP calculation of 
TOV/GOV

Use API calculation of 
TOV/GOV

Set if you wish to use American (US) style calculations, which 
perform the floating roof and free water corrections at a 
different stage to the British calculations.

Disregard suspended 
sediment and water

Include suspended 
sediment & water

Set if you want include sediment and water correction in your 
inventory calculations

Combined sediment & 
water calculation

Separate sediment & 
water calculation

Set if you want sediment and water correction calculated 
separately

Water density 
1.0 kg/l for fresh water

Water density 
1.020 kg/l for sea 
water

Set according to whether the water you have in your tanks is 
fresh or sea water

Net values calculated 
from gross

Net values calculated 
from NOV-NSV chain

If set, net values are calculated from gross, otherwise from 
prior calculated NOV and NSV values. Only applicable to IP 
calculation methods

Mass calculated from 
standard conditions

Mass calculated from 
observed conditions

–

Range checking is 
enabled

Range checking is 
disabled

If set, checks to ensure input values are within acceptable 
range are turned off

WCF uses main 
Table 56

WCF uses short 
Table 56

Weight correction factor calculations use ‘Table 56’. This 
exists in a ‘short’ or ‘main’ version. If set, the short version 
will be used

VCF is normal VCF is restricted When set, VCF output is restricted to 4 decimal places

Use equilibrium 
pressure as per 
D1250/04

Use equilibrium 
pressure as per 
D1250/04 
addendum 1

When set, the 2007 addendum to MPMS 11.1 D1250/04 
regarding equilibrium pressure is applied

Use Calculated Data Use Tabular Data When set, the data for WCF is obtained from a lookup table 
rather than being calculated

Use Metric table for 
WCF calculation

Use Imperial table for 
WCF calculation

Only valid if the ’Use Tabular Data’ option is set. When set, 
the WCF is derived from Table 57 (imperial). Otherwise 
Table 56 (Metric) is used

Use normal WCF value Use reciprocal WCF 
value

Only valid if the ’Use Tabular Data’ and the ’Use Metric table 
for WCF calculation’ options are selected. When set, the WCF 
value will be obtained from the ’litres/Metric Ton’ column of 
Table 56. Otherwise the ’Metric Ton/litre’ column is used

Volume Pressure
Determines whether mass values are derived from volumetric 
data or from pressure inputs

Volume Mass The calculated Barrel Conversion Factor is to be used to 
convert volume or mass values
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Appendix C – Tank Inventory Flags

Setting 1 (unset) Setting 2 (Set) Explanation

Gauge levels are 
innage

Gauge levels are ullage The levels returned by the gauge are innage (referenced from 
the bottom) or ullage (referenced from the top)

Ullage level zero = 
Max. Operating Level

Ullage level zero = 
Reference Height

Zero ullage is taken as the highest safe working level or the 
maximum height of the tank

Gauge reads reference 
density

Gauge reads observed 
density

Note! Use this setting with care!
When set the inventory calculator derives the reference 
density from the observed density information, if you enter 
manual densities be aware of whether you enter a reference 
density or an observed density

Gauge reads density in 
vacuum

Gauge reads density in 
air

When set an allowance for the density of air will be made 
during inventory calculations

Gauge reads relative 
pressure

Gauge reads absolute 
pressure

Internally pressures are stored in Bar absolute, checking this 
option will cause the pressure stored to be calculated from the 
gauged value

Roof weight specified 
in air

Roof weight specified 
in vacuum

If you know the mass of your floating roof, set to Roof Weight 
Specified in vacuum

Disable tank shell 
correction

Enable tank shell 
correction

When checked the tank shell correction calculation will be 
performed, enter shell correction information on the relevant 
tab in this module

Do not apply 
hydrometer correction 
in VCF

Apply hydrometer 
correction to VCF

Set according to whether hydrometer correction is required or 
not

Tank calculated as 
hydrocarbon storage

Tank calculated for 
ballast/slops storage

When set movements in and out of the tank are assumed to 
leave a constant oil depth and vary the amount of water in the 
tank

Use product 
temperature in vapour 
correction

Use vapour 
temperature in vapour 
corrections

Sets which temperature is used by vapour corrections

Average gauge 
temperature is product 
temperature

Average gauge 
temperature is vapour 
temperature

Selecting vapour temperature as the source of average 
temperature disables product temperature

Dip thermal correction 
is disregarded

Dip thermal correction 
is enabled

Set if correction for temperature is applied to dip

Gauge dip type is 
Ullage

Gauge dip type is 
Innage

If Dip thermal correction is enabled, selects which type of 
gauge to apply correction to

Disable correction for 
Buoyancy gauges

Enable correction for 
Buoyancy gauges

When set, correction is applied for buoyancy type gauges

Liquid pressure is from 
P1

Liquid pressure is from 
P2

Determines where liquid pressure is read from. Can also be set 
to read Liquid Pressure from P3

Compressibility factor 
is disregarded

Compressibility factor 
is applied

If set, the compressibility factor will be applied to calculations

Tank shell is not 
insulated

Tank shell is insulated If set, tank shell insulation will be included in calculations
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